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WebSphere Business Process Management  
Enabled by SOA 

 
Uses VMWare Image 1 

 

Start the “1.Business Process Management PoT” image, this will be 
used for days 1 & 2 of the workshop 

 
 

Lab Preparation 
__1.  In the lower right corner of your screen, verify that the Database Manager is currently running by 

checking that the DB2 icon does not have a red mark. 

 Running:   Not running:   

 

If not running, then right-click on the DB2® icon.  From the popup menu, select Start (DB2). 
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__2.  From the desktop, open the PoT Lab Shortcuts folder. 

 

__3.  Double-click on the Start Servers icon in the folder. 

 
 

A Command Prompt window will appear. 
 

 
 
This will start the required server for the labs.  The Command Prompt window will automatically 
close when the server has started. 
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Introduction 
 

In this lab exercise, you will be implementing a business process from the ground up for verifying 
accounts.  This business process will be called SimpleAccountVerification, and will be used to process 
requests to open accounts.  This business process will consist of activities such as performing credit 
checks, risk assessments, approvals, and pricing plan selections.   

 

The main objectives include: 
 Business agility 

 Development flexibility 

 Runtime dynamicity 

 Easier integration 

 Governance 

 Reuse of assets 

 Risk Reduction 

 

The IBM® SOA Foundation and the WebSphere® Business Process Management software portfolio will 
be used to achieve these goals.  The focus will be on the Model, Assemble, Deploy, and Manage phases 
of the SOA lifecycle. 

 
You will use the WebSphere Business Modeler to define the business model, and then WebSphere 
Integration Developer for application assembly.  The WebSphere Process Server built into the 
WebSphere Integration Developer will be used for deployment and testing.  You will also use the 
WebSphere Service Registry and Repository for governance, service metadata and reuse. 

 

Once the business process has been implemented and deployed, you will also perform several iterative 
changes to the process to illustrate how quickly this can be accomplished.  This type of business 
flexibility is one of the primary benefits of SOA. 



IBM   

SOA PoT – Lab handouts, Part 1 Page 7 

  

 

Important! 
If you encounter problems during the course of this lab, please call the attention 
of the class instructor or any of the lab assistants. 

 

 

Scenario 
 

Your organization has several core business processes that need to be significantly improved.  These 
processes are composed of business activities which are currently manual tasks, or implemented using 
standalone systems.  These processes are currently not implemented end-to-end, which significantly 
limits business flexibility.   

 

In this lab exercises, you have been assigned to integrate a very simple business process for handling 
account applications. This will be called the SimpleAccountVerification process. This is your 
organization’s first SOA project, so we will keep it simple and incremental.  This will involve a very 
rudimentary process of determining whether a request to open an account will be approved or rejected.  
This generic example can apply to loan applications, revolving credit applications, or other similar 
scenarios. 

 

As you go through the different labs, you will be playing different roles, such as a business analyst, 
architect, integration developer, and web service developer.   

 
Icons 
 

The following symbols appear in this document at places where additional guidance is available. 

Icon Purpose Explanation 

 
Important! 

This symbol calls attention to a particular step or command. 
For example, it might alert you to type a command carefully 
because it is case sensitive.  

 
Information This symbol indicates information that might not be 

necessary to complete a step, but is helpful or good to know.  

 

Trouble-
shooting  

This symbol indicates that you can fix a specific problem by 
completing the associated troubleshooting information.  
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Lab 1 Promote Standards and Initiate Governance 
 

Goals: 

• Ensure success of SOA projects 

o Initiate lifecycle governance 

o Reuse assets and promote standards 

• Align business with IT 

o Define classifications 
 
Roles:  Enterprise Architect, Administrator 
You are a member of the enterprise architecture team tasked with enforcing enterprise-level standards, 
such as common service interfaces and business object definitions.  This assumes that the necessary 
SOA analysis and design activities have already been performed, and these efforts have produced 
artifacts capturing standard definitions.  In this lab, you will publish several of these artifacts.   

First, you’ll publish an XML Schema Definition (XSD) file containing the following standard data objects: 

Customer Basic customer information 

CustomerApplication Application submitted by the customer as part of the loan request 

  

Next, you’ll load the approved interface for Credit Report web services.  Then, you’ll create a standard 
classification of Credit Report services to indicate whether a Credit Report service is internal or external. 

1.1 Open the WebSphere Service Registry and Repository console 

__1.  Switch to the PoT Lab Shortcuts folder.  Double-click on the WebSphere Service Registry 
and Repository link.  Reopen the folder from the desktop if needed. 

 
 

The default web browser appears showing the WebSphere Service Registry and Repository 
Console logon screen. 
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Hint 
The URL for the WebSphere Service Registry and Repository is 
http://localhost:9080/ServiceRegistry.  

 

__2.  If a Security Alert warning appears, click on Yes to proceed. 

 

 

Troubleshooting 
If the WebSphere Service Registry and Repository console does not appear, or you 
encounter web page errors, wait for the Command Prompt window started earlier to 
automatically close.  This will indicate that the servers have started. 

1.2 Switch to a different profile 
 

 

What next? 
The WebSphere Service Registry and Repository allows you to set up different profiles 
for specific needs. Only one profile can be active.  In the next steps, you will switch 
from the default profile to the sample governance profile. 

 

__3.  From the Perspective drop-down list, select Configuration, and then click on the Go button 
beside it. 

 
 

 

Hint 
Profiles contain their own set of perspectives. Notice that the list only shows three 
perspectives to choose from. These are the perspectives available in the currently active 
profile. Aside from being able to create your own profile, you can also create your own 
perspectives for the different roles in your organization, such as for an Administrator, 
Business Analyst, Architect, Developer, and User. 

 

http://localhost:9080/ServiceRegistry�
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__4.  Expand the Manage Configuration Profiles section. Click on Configuration Profiles. 

 
 

__5.  Select WSRR_GOVERNANCE_PROFILE.  Click on Make Active. 

 
 

 

Hint 
You have switched to a sample profile (WSRR_GOVERNANCE_PROFILE) that is 
provided with the product to help you get started quickly.  The default profile is intended 
for those who want to start from the ground up.  The sample Governance profile contains 
a well-defined service model, with sample definitions of templates, lifecycles, validators, 
classifications, roles and perspectives. 

 

__6.  Refresh the browser so that the new active profile will be reflected in the web page. 
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1.3 Define how services should be classified 

__7.  Expand the Active Configuration Profile section. Click on Classification Systems. 

 
 

__8.  Click on New. 

 
 

__9.  Enter the following values: 

Field Value 

URI http://www.mycompany.com/Taxonomy 

Name Credit Report Services Visibility 
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__10.  Click on the Classes tab. 

 
 

__11.  Click on Add Root Class. 

 
 

__12.  Enter the following values.  Just append Internal to the Class ID. 

Field Value 

Class ID http://www.yourcompany.com/Taxonomy#Internal 

Name Internal 

 

 
 

__13.  Click on OK. 

__14.  Click on Add Root Class again.   

__15.  Enter the following values.  Just append External to the Class ID. 

Field Value 

Class ID http://www.yourcompany.com/Taxonomy#External 

Name External 
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__16.  Click on OK. 

__17.  Click on Save and Commit. 

 
 

 

What did you just do? 
A new classification has been defined. The Credit Report services that will be loaded in 
later labs can be classified as either an Internal or External service. 

 

1.4 Load the standard data object definitions 

 

What next? 
Your organization has decided to use standard data objects for Customer and 
CustomerApplication information. 

 

__18.  From the Perspective drop-down list, select GP Architect.  Click on the Go button. 

 
 

Notice that the new active profile now provides more perspectives for specific roles. 
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__19.  Scroll to the bottom of the web page.  Click the Browse button and select 
C:\PoT\BPMSOA\Businessitems.xsd. 

 
 

 

The file Businessitems.xsd contains the standard definition of the Customer and 
CustomerApplication business objects. 

 

__20.  For the Document type, select XSD.  Click on OK. 

 
 

__21.  Click on Finish. 
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A message will appear indicating that the document was loaded successfully. 

 
 

 

What just happened? 
The Businessitems.xsd has been successfully loaded in the WebSphere Service Registry 
and Repository.  The standard Customer and CustomerApplication data objects defined 
in the Businessitems.xsd file are now ready to be reused by other projects. 

 

1.5 Define a new business process and apply governance 

 

What next? 
The goal of these labs is to develop and deploy a business process called 
SimpleAccountVerification. Before you start modeling and assembling this process, 
you will first need to define the SimpleAccountVerification process in the WebSphere 
Service Registry and Repository. This is to let other business units or teams in your 
organization know about your plans so they can consider reuse and set up subscriptions 
and notifications.  This will also allow governance to be applied to the lifecycle of the 
process to ensure that certain requirements are satisfied before the process can move 
through the different phases of its lifecycle.  

 

Role:  Business Analyst 

__22.  Let’s now assume the role of a business analyst. Select the GP Analyst perspective, and then 
click on Go. 

 
 

__23.  Expand the Business Metadata and Business Service View sections.  Click on Business 
Processes. 
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__24.  Click on New. 

 
 

__25.  For the Name, specify SimpleAccountVerification. Click on OK. 

 

__26.  Click on SimpleAccountVerification. 

 
 

__27.  Click on the Governance tab. 
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__28.  Select InitiateInterfaceLifecycle.  Click on Govern. 

 
 

 

Hint 
You actually selected the wrong lifecycle type. However, there is already a governance 
validation mechanism in place to ensure that the correct lifecycle is selected. This will 
result in an error message. 

 

__29.  Expand the governance validation message by clicking the + sign. 

 
 

__30.  Click on the web browser Back button.    

 

__31.  Select InitiateServiceLifecycle.  Click on Govern. 
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Notice that the SimpleAccountVerification process is now in the Model state. 

 
 

 
What are the different states in each lifecycle?  The next steps will illustrate this. 

 

__32.  Expand Governance Lifecycle View. Expand Governed Entities. Expand Service Lifecycle. 

 
This shows the different states or phases in the Service Lifecycle. You can also view the other 
Lifecycles that have been defined in this sample profile. 

 

 

What next? 
You are now ready to model the SimpleAccountVerification process. 

 

 

  Please wait for the next lecture before proceeding to the next lab. 
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Lab 2 Model the Business Process 
 

Goals: 

• Align IT to business processes 

o Initiate business-driven development 

o IT organized as business tasks and services 

• Capture more precise business models 

• Lower business costs 

o Run simulations before allocating time and resources 
 

Role:  Business Analyst 
In this Model phase, you will assume the role of a Business Analyst.  You have been given the 
responsibility of documenting an existing business process which handles account verifications.  This 
Account Verification process is part of a larger Account Open process which allows customers to submit 
requests to open an account.  The customer submits the application form with the required information, 
and then a credit report is performed to determine the applicant’s credit score.  A credit risk assessment 
is then completed based on the credit score, which will result in a risk rating of either HIGH or LOW.  A 
request with a high risk rating will automatically be rejected.  A request with a low risk rating will be 
approved and a pricing plan will be determined. 

 

The simple model you will build is illustrated in the following screenshot: 
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2.1 Start the WebSphere Business Modeler 

__1.  Switch to the PoT Lab Shortcuts folder.  Double-click on 04 IBM WebSphere Business 
Modeler Advanced 6.1.  Reopen the folder from the desktop if needed. 

 
 

The WebSphere Business Modeler will appear. 

 

__2.  Close the Product Welcome view. 

     or      

 

__3.  On the Quickstart Wizard, specify the following.  
 

  

 

 

Use the default for the Process catalog name field. 

 
 

 

Project Name SimpleAccountVerification 

Process Name SimpleAccountVerification 
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__4.  Uncheck the Always show this wizard on startup option.  Click on Finish. 

 
 

__5.  Wait for the progress indicator to disappear. 

 
 

__6.  Maximize the WebSphere Business Modeler window if needed.   

 

2.2 Define the business model 

__7.  From the toolbar, click on the Apply 1-pane layout button. 

 
 
 
This will simplify the layout and hide the advanced features and views for now. 
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__8.  In the canvas or white-space area, right-click and then select Auto-Layout Left to Right. 
 

 
 
This will compress all the default elements and make them easier to find.  By default, the 
business model will initially have Process start and Process stop elements positioned in the 
corners of the canvas, but should now be visible. 

 

__9.  Select the two default process elements and press the Delete key.  You will not need these 
elements for the business model you are creating. 

 
 

 

Troubleshooting 
You can undo any incorrect actions by either pressing Ctrl-z, or selecting Edit->Undo 
from the menu bar. 

 

__10.  From the palette on the left, select the element Create local task. 
 

 
 
This element will represent a business task in the business process you are diagramming.  Keep 
in mind that this element typically should not represent programs, applications, databases, or 
any other software component, but rather high-level activities composing a business process. 
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__11.  Click on the canvas to drop the local task element.  By default, the name of the element should 
be in edit mode.  Label the element as Credit Report.  (You do not need to drag and drop.) 
 

 
 

 

Tip 
To rename the element, just highlight the element, wait 1-2 seconds, then click on the 
element again.  The label will be in edit mode. 

 

__12.  Select three more local task elements and drop them into the canvas.  Rename these new 
elements as Credit Risk Assessment, Pricing and Approval and Generate Decline.  Position 
the elements similar to the screenshot. 

 
These four elements will represent the four tasks in our simple account verification scenario.  
These tasks will later be implemented as invocations to applications or external systems. 

__13.  From the palette, select the element Create simple decision and drop it in the middle of the 
three new elements. 
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__14.  From the palette, click on the small arrow on the element Create start to display a submenu of 
elements. 

    
 

__15.  Select the element Stop. 

 
 

__16.  Drop to the right of both the Pricing and Approval element and the Generate Decline element.                  

 
 

__17.  Click on Ctrl+s to save your current progress. 

 

2.3 Connect tasks to define process flow 
 

__18.  From the palette, click the Connections button.   

This will allow you to start defining the flow through the different tasks to represent the business 
process flow. 
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__19.  Click on the left border of the canvas, and then click on the Credit Report task.   

 

 
 
This connection indicates that the Credit Report task will be invoked first and will be passed 
some text information as a parameter. 

__20.  Complete the following connections:  
 

 

__21.  From the palette, click on the Select button to switch out of connection mode.   

__22.  Right-click on an empty space in the canvas.  From the popup menu, select Auto-Layout Left to 
Right. 
 

 
 
The wiring of all the business tasks to define the process flow is now complete.  You will now 
configure the business item that will be used by the business tasks. 

 

__23.  Click on Ctrl+s to save your current progress. 
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__24.  Close the SimpleAccountVerification Model editor. 

  
 

__25.  From the Project Tree view, expand the elements in the Project list until you can select 
SimpleAccountVerification -> Business service objects. 

 
 

 

What next? 
The next step is to reuse the standard business objects defined in the Businessitems.xsd 
file previously loaded into the WebSphere Service Registry and Repository.  In this 
SimpleAccountVerification process, the customer information required for verification 
will be stored in the standard business object CustomerApplication.  This 
CustomerApplication object definition will be retrieved from the WebSphere Service 
Registry and Repository and stored in the Business service objects folder highlighted 
above. 

 

__26.  From the Project Tree, right-click on the Business service objects folder.  From the popup 
menu, select Business Service Search. 

 

__27.  Click on Add. 
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__28.  Specify wsrrpot in the Name field. Accept the defaults for the other fields. 

 
 

__29.  Click on OK. 

 

 

What just happened? 

You created a connection to the WebSphere Service Registry and 
Repository server, and specified an alias name of wsrrpot. This will 
allow you to find and publish artifacts to the server from within this 
development environment. 

 

__30.  Select wsrrpot, and then click on Test Connection.  Verify that a “Connection successful” 
message is displayed. 

 
 

__31.  Click on Next. 
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__32.  Specify Busi* as the Search criteria (case-sensitive).  Select the Business service objects 
(XSD) option, and then click on Search.   

 
 

__33.  The file Businessitems.xsd is found. Expand Businessitems.xsd. 

 

__34.  Select the All button  to move Businessitems.xsd to the Files to import column. 

 
 

__35.  Click on Finish. 

 

__36.  From the Import status information window, click on OK. 
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What just happened? 

The Businessitems.xsd has been imported, and the CustomerApplication 
and Customer objects can now be reused in the 
SimpleAccountVerification business model. 

 

__37.  From the Project Tree view, double-click on SimpleAccountVerification -> Processes -> 
SimpleAccountVerification. 

 
 

This will open the business model you created earlier. 

__38.  Select the Pricing and Approval element. 

 
 

__39.  On the Properties area at the bottom section of the screen, select the Attributes - Pricing and 
Approval tab, and then select the Inputs tab. 

 
 

__40.  Click on the Associated data column. 

 
 

__41.  Click on the Browse button.   
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__42.  Expand SimpleAccountVerification to select CustomerApplication. 

 
 

__43.  Click on OK. 

__44.  Verify that the Associated data is now set to CustomerApplication. 

 

__45.  Select the Outputs tab.   

__46.  Click on the Associated data column. 

 

__47.  Click on the Browse button.   

 

__48.  Expand SimpleAccountVerification to select CustomerApplication. 
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__49.  Click on OK. 

__50.  Verify that the Associated data is now set to CustomerApplication. 

 
 

 

What just happened? 
You just specified that the CustomerApplication object will be used for both the input 
and output of the Pricing and Approval task. 

 

What’s next? 
You will now also specify the CustomerApplication object as the input and output for 
the Generate Decline task. 

__51.  Select the Generate Decline element. 

 

__52.  On the Properties area at the bottom section of the screen, select the Attributes - Generate 
Decline tab, and then select the Inputs tab. 

__53.  Click on the Associated data column. 

 

__54.  Click on the Browse button.   

__55.  Expand SimpleAccountVerification to select CustomerApplication. 
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__56.  Click on OK. 

__57.  Verify that the Associated data is now set to CustomerApplication. 

 
 

__58.  Select the Outputs tab.   

__59.  Click on the Associated data column. 

__60.  Click on the Browse button.   

__61.  Expand SimpleAccountVerification to select CustomerApplication. 

__62.  Click on OK. 

 

__63.  Verify that the Associated data is now set to CustomerApplication. 

 
 

 

What just happened? 

You also specified the CustomerApplication object as the input and 
output for the Generate Decline task. 

 

__64.  Click on Ctrl+s to save your current progress. 

 

__65.  From the Project Tree view, expand the Business service objects folder. Double-click on 
CustomerApplication. 
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This will open the CustomerApplication business object view. 

 

 
 
This is the data structure of the CustomerApplication business object.  As you can see, it also 
contains a nested Customer business object. 
 

__66.  Close the CustomerApplication business object view.   

 
 

 

What’s next? 
You will  now use the drag and drop approach for specifying the input and output objects 
of the other tasks. 

 

__67.  From the Project Tree view, select CustomerApplication. 

 
 

__68.  Drag and drop the CustomerApplication business object on the connection between the left 
border of the canvas and the element Credit Report.   
 

 

Tip 
A dotted box appears when the object is ready to be dropped on the connection. 
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This drag and drop action sets up the business item CustomerApplication as the input to the 
activity Credit Report.  The connection should now look similar to this: 
 

 

__69.  Drag and drop the CustomerApplication business object on the connection between the Credit 
Report task and the Credit Risk Assessment task. 

 
 

__70.  Drag and drop the CustomerApplication business object on the connection between the Credit 
Risk Assessment task and the Decision element. 

 
 

__71.  Click on Ctrl+s to save your current progress. 

 

 

What’s next? 

You will now specify the logic for the decision element to determine 
whether the request will be approved or rejected. 
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__72.  From the menu bar, select Modeling->Mode->Intermediate.   
 

 
 

 

Tip 
This mode will provide more advanced tooling capabilities. Specifically, this will allow 
you to provide logic to the Decision element.  This will also display more information on 
the business model diagram. 

 

__73.  From the business model editor, select the Decision element. 

 
 

__74.  On the Properties area at the bottom section of the screen, click on the Attributes - Decision 
tab, and then the Output branches tab. 

 
 

__75.  Select the row for the Yes output branch. 
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__76.  Double-click on the Attributes - Decision view titlebar to maximize the view. 

 
 
 

 

Tip 
You can maximize any view by double-clicking on its titlebar.  Double-clicking again on 
the titlebar will restore the view to its original size. 

 

__77.  On the lower-right corner of the view, click on Edit.  Scroll down if necessary. 

 
 
The Expression Builder window will appear. 

 

__78.  Click on Add. 
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__79.  In the Expression Composer section, expand the First term details tree list, and then select 
creditRiskAssessment.  Ensure that you are selecting creditRiskAssessment from the Input 
parent branch, and not the Input Criterion branch. 

 
 

 

Important! 
Ensure that you are selecting creditRiskAssessment from the Input parent branch, and 
not the Input Criterion branch. 

 

__80.  Make the following selections: 

Operator is equal to 

Second term Text 

Text value LOW 
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__81.  Click on Apply.   

__82.  Ensure that the Expression text contains the following expression. 

 
 

__83.  Click on OK. 

This will also automatically create an inverse expression for the No output branch. 

__84.  Double-click on the Attributes - Decision view titlebar to restore the view to its original size. 

 

__85.  Press Ctrl+s or click on the Save button on the toolbar.   

__86.  Click on the Errors tab and ensure that there are no errors listed.  

 
 

 

What just happened? 
You have just completed modeling a simple account verification process. For the sake of 
simplicity, you just used the default names for the task operations and the input and 
output variables.  The operation names will typically default to InputCriterion.  Also by 
default, input variables will typically be named input1, and output variables will be 
named output1. 

 

 

What’s next? 
The business model will now be exported to the file system as a BPEL version of the 
model.  In the next lab, this BPEL model will be imported into the WebSphere 
Integration Developer for assembly. 

 

 

Troubleshooting 
If the business model was not completed successfully, or was not exported successfully, 
then you can still proceed to the next lab.  A solution version of the model is available if 
needed. 
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2.4 Export the business model as a BPEL process 

__87.  From the menu bar, select File -> Export. 

__88.  From the Export window, expand WebSphere Business Modeler.  Select WebSphere 
Business Modeler Export. 

 
 

__89.  Click on Next. 

__90.  From the next window, select WebSphere Integration Developer. 

 
 

Selecting WebSphere Integration Developer as the export type will export the business model 
as a BPEL process and stored in a Project Interchange file. 

 

__91.  Click on Next. 

__92.  Specify a Target directory of c:\lab. 

 
 

__93.  Select the option Export entire project and related projects.  
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__94.  Click on Next. 

__95.  If a window appears asking if you would like to create the target directory, click on Yes. 

 
 

__96.  Ensure that the Recommended Export Option is selected. Uncheck the Append timestamp 
option. 

 
 

__97.  Click on Finish. 

 

__98.  From the Export finished window, click on OK.  
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What just happened? 
The business model has now been exported into the file system as a BPEL process 
contained in a Project Interchange file. It is ready for import into the WebSphere 
Integration Developer. 

 

__99.  From the main menu, select File -> Exit to close the WebSphere Business Modeler. 

 

 

The “Model” phase of our SOA project is now complete.   
 
 
 

  Please wait for the next lecture before proceeding to the next lab. 
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Lab 3 Apply Governance to the Process Lifecycle 
 

Goals: 

• Ensure success through lifecycle governance 

o Transition from model phase to assemble phase 
 

Role:  Architect or Project Manager 
The business model for the SimpleAccountVerification process has been completed and is ready for 
implementation and assembly.  However, you made the process governable in an earlier lab because 
you need the proper validation and control mechanisms to ensure the success of this SOA project. This 
involves ensuring that certain requirements are met before the SimpleAccountVerification process can 
transition from the model phase to the assembly phase. You will now attempt to transition the process to 
the assembly phase and see how governance can be applied to the process lifecycle. 

3.1 Transition SimpleAccountVerification Process to Assemble State 

__1.  Switch to the web browser showing the WebSphere Registry and Repository console. 

 

 

Troubleshooting 
If the WebSphere Service Registry and Repository console was closed, just reopen using 
the link in the PoT Lab Shortcuts folder. 
 

 
 
You can also open a web browser and go to http://localhost:9080/ServiceRegistry.  

 

__2.  Select GP Architect from the Perspective drop-down list.  Click on the Go button. 

 

http://localhost:9080/ServiceRegistry�
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__3.  Expand the Business Metadata and Business Service View sections.  Click on Business 
Processes. 

 
 

__4.  Click on SimpleAccountVerification. 

 
 

__5.  Click on the Governance tab.   

 

 

What’s next? 
You will now transition the SimpleAccountVerification process from the “Model” phase 
to the “Assemble” or implementation phase.  You will then need to satisfy certain 
requirements before the governance validators will allow you to perform the transition. 

 

__6.  Click on Transition. 

 
 

A governance validation error message appears. 
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__7.  Expand the governance validation message by clicking the + sign. 

 
 

 

What just happened? 
A Governance Validator exists as part of this sample profile to ensure that the following 
requirements are satisfied before the SimpleAccountVerification process will be 
authorized for development and transitioned to the Assemble state: 

 Owning organization must be specified 
 Must be assigned to a Business Domain classification 

 

__8.  Click on Organizations. 

 
 

__9.  Click on New.   

 

__10.  Specify a Name of Finance. Click on OK. 
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__11.  Click on Business Processes. 

 
 

__12.  Click on SimpleAccountVerification. 

 
 

 

What’s next? 
You just defined the Finance department as an organization in WebSphere Service 
Registry and Repository. The next step is to specify that the Finance department owns 
the SimpleAccountVerification process by defining a relationship. To define a 
relationship, you search for the target of the relationship with the 
SimpleAccountVerification process. 

 

__13.  Click on Owning Organization. 

 
 

__14.  Click on Add.   

__15.  Click on Next. 
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__16.  Specify Fin* as the search criteria.  Click on Next. 

 
 

__17.  Select Finance. Click on Next. 

 
 

__18.  Click on Finish. 

 
 

Another governance validation message appears indicating that the Finance Organization must 
first be governed before it can be specified as the Owning Organization of the process. 
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__19.  Click on Organizations. 

 
 

__20.  Click on Finance. 

__21.  Click on the Governance tab.   

 

__22.  Select the Default transition. Click on Govern. 

 
 

The Governance State should now be LifecycleSelection.  This means that the next transition 
step is to select the proper governance lifecycle profile, but this will not be needed for this lab. 

 
 

__23.  Click on Business Processes. 

 
 

__24.  Click on SimpleAccountVerification. 
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__25.  Click on Owning Organization. 

 
 

__26.  Click on Add.   

__27.  Click on Next. 

 
 

__28.  Specify Fin* as the search criteria.  Click on Next. 

 
 

__29.  Select Finance. Click on Next. 
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__30.  Click on Finish. 

 
 

You should now be able to complete the creation of the relationship. 

 

 

What just happened? 
The Finance department has been specified as the Owning Organization of the process. 
You have now satisfied the first governance requirement for authorizing the 
development of the process. 

 

__31.  Click on the SimpleAccountVerification link. 

 
 

__32.  Click on Classifications. 

 
 

__33.  Expand Governance Profile Taxonomy and Business Domain. 
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__34.  Select Finance.  Click on Add. 

 
 

Finance has been added to the classification list. 

 
 

__35.  Click on OK. 

 

 

What just happened? 
The process has been classified as being part of the Finance Business Domain. You have 
now satisfied the second governance requirement for authorizing the development of the 
process. You should now be able to transition the process to the Assemble state. 

 

__36.  Click on the Governance tab.   

__37.  Click on Transition. 

 
 

The SimpleAccountVerification process is now in the Assemble phase. 
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What’s next? 
The process has been authorized for development. You will now import the process 
defined in the WebSphere Business Modeler into the WebSphere Integration Developer 
for implementation and assembly. 

 

 

 

  Please wait for the next lecture before proceeding to the next lab. 
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Lab 4  Assemble and Deploy the Process 
 

Goals: 

• Assemble service components to form business process 

• Lower business costs and achieve IT flexibility 

o Apply the building-block approach 

o Integrate using modular service components 

o Loosely-couple service components for flexibility 
 
Role:  Integration Developer 
You will now assume the role of an Integration Developer who is responsible for assembling the different 
service components to compose the business process. The next steps will illustrate how loose-coupling 
and the building-block approach can be applied to make integration at the enterprise scale significantly 
easier. 

4.1 Start the WebSphere Integration Developer 

__1.  Switch to the PoT Lab Shortcuts folder.  Double-click on 05 IBM WebSphere Integration 
Developer 6.1.  Reopen the folder from the desktop if needed. 

 
 
The WebSphere Integration Developer Welcome view should appear by default. 
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__2.  Maximize the WebSphere Integration Developer window.   

__3.  Click on the Workbench icon to close the Welcome view. 

 
 
 
The Business Integration perspective now appears. 

 

__4.  From the main menu, select Window -> Reset Perspective. 

 
 

 

Troubleshooting 
The perspective can be reset to display all the default views in their default locations. 
This will help in situations where a needed view cannot be found. 

 

__5.  From the Reset Perspective confirmation window, click on OK. 

 

 

What’s next? 
You will now import the business model that was created in the previous lab. The 
business model was exported as a BPEL process. 
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4.2 Import the business model into the WebSphere Integration Developer 

__6.  From the main menu, select File -> Import. 

__7.  Expand the Other category. Select Project Interchange as the import source. Click on Next. 

 
 

__8.  Click the Browse button for the From zip file field. 

 
 

__9.  Select the file C:\lab\SimpleAccountVerification.zip.  Click on Select All. 

 
 

 

Troubleshooting 
If the file C:\lab\SimpleAccountVerification.zip does not exist because the previous lab 
was not completed successfully, then you can use the file 
C:\PoT\BPMSOA\Solutions\SimpleAccountVerification.zip. 
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__10.  Click on Finish. 

 

__11.  In the lower right corner of the window, if a progress indicator appears, wait for it to disappear 
before proceeding. 

 
 

 

What’s next? 
The imported BPEL process still needs to be completed or assembled. The tasks or 
activities in the process still need to be implemented or wired to their corresponding 
service endpoints. 

 

4.3 Assemble the business process 

__12.  From the Business Integration view, in the SimpleAccountVerification module, double-click on 
Assembly Diagram. 
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This will open the Assembly Diagram editor for the main module.  Refer to the screenshot below.  
The main module contains the BPEL process.  You will also notice two other modules in the 
Business Integration view.  You will work with these modules later. 
 

 
 

 

Hint 
Why are there three modules?  You can actually just work with one module, which will 
simplify development.  However, three modules provide a clearer separation and better 
flexibility.  Changes later on will have a smaller impact.  Here are brief descriptions of 
each module: 

 SimpleAccountVerification  -  main module which contains the BPEL process and 
the overall assembly diagram. 

 SimpleAccountVerification_impl  -  implementation module which contains the 
implementation of the tasks defined in the BPEL process, as well as other related 
components. 

 SimpleAccountVerification_lib  -  library module which contains the interface 
definitions, business object definitions, maps, and other non-executable artifacts 
that need to be shared across different modules. 

 
By separating the implementation module from the main BPEL module, changes made 
to the task or service implementations will not require a redeployment of the main 
module.  By using a separate library module, it becomes easier to distribute and enforce 
standard definitions, such as a standard credit report service interface, or a standard 
customer object.  
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__13.  Double-click on the Assembly Diagram editor tab to maximize the view. 

 
 

 

Hint 
Double-clicking on the tab again will restore the view back to its original size.  For now 
keep the view maximized so you’ll have more screen space to work with. 
You can also double-click on any view titlebar or tab to maximize or restore the size. 

 

__14.  From the Assembly Diagram editor, double-click on the SimpleAccountVerification process. 

 
 
The SimpleAccountVerification process editor appears. 
 

__15.  Review the SimpleAccountVerification process. 

 
This is the BPEL version of the business model defined using the WebSphere Business Modeler.  
BPEL will be explained later on.  Because this was exported from the WebSphere Business 
Modeler, it is already complete and does not require further development.  
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__16.  Close the SimpleAccountVerification process editor.   

The Assembly Diagram editor will reappear. 

 

__17.  Close the Assembly Diagram editor.   

 

 

What’s next? 
You’ll make a simple change to the process imported from the WebSphere Business 
Modeler. Specifically, you’ll rename the operation name for the Credit Report Service to 
something more meaningful. 

 

__18.  From the Business Integration view, expand SimpleAccountVerification_lib.  Expand 
Interfaces to expose CreditReport. 

__19.  Double-click on Credit Report. 

 
 

This will open the Interface Editor for the CreditReport service. 

 

__20.  Place the cursor on any part of the operation name InputCriterion. 
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__21.  Press Alt+Shift+R to refactor/rename the operation name. 

 

__22.  Change the operation name to creditReport.  Select Update references. 

 
 

 

__23.  Click on OK. 

 

The operation name should now be creditReport. 

 
 

 

Hint 
Renaming through the refactoring capabilities of this development environment will also 
rename all references to the name in other components. This will synchronize your 
changes and avoid introducing errors.  Refactoring in general is an essential capability 
with this type of integration development. 

 

__24.  Close the CreditReport Interface Editor.   
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What’s next? 
At this point, the tasks of the business process have been defined, as well as the flow 
through these tasks.  However, the tasks have not yet been implemented.  The next step 
is to implement the four tasks of our simple process. 
 

      
 
These tasks will initially be implemented using Java™ code because the required back-
end systems are still under development.  The Java code will serve as stubs or 
placeholders until the actual systems become available. 

 

 

4.4 Implement the tasks of the business process 

__25.  From the Business Integration view, double-click on SimpleAccountVerification_impl -> 
Assembly Diagram. 
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This will open the Assembly Diagram editor for this module. 

 
 

 

Hint 
This Assembly Diagram editor is where you will implement the four tasks of the 
SimpleAccountVerification process.  The components on the left side are the Export 
components.  The components on the right side are the Import components.   
 
Export components allow a module to offer a service to others. Exports define 
interactions between modules and service requesters. Specifically, Exports define how 
the service implementations or endpoints can be accessed by others. 
 
Import components allow a module to access external services as if they were local. 
Imports define interactions between modules and service providers. Specifically, Imports 
represent the implementations or service endpoints.   

 

This Assembly Diagram editor is where you will implement the four tasks of the 
SimpleAccountVerification process. 

 

__26.  Double-click on the PricingandApproval component. 

 
 

 

 

 



IBM   

Page 62 SOA PoT  

__27.  From the Open confirmation window, click on Yes. 

 
 

__28.  Select Java as the implementation type. Click on OK. 

 
 

__29.  From the Generate Implementation window, accept the default selection, and then click on OK. 

 
 

The Java editor appears for the implementation of the PricingandApproval component. 
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__30.  Scroll down to the bottom of the Java code.  Select the highlighted text below and delete. 

 
 

__31.  Type pricapp in the line of code as shown below.  Press Ctrl+spacebar. 

 
 

 

Hint 
The Ctrl+spacebar key combination activates a special feature called Code-Assist.  This 
will add code snippets based on predefined code templates. 

 

A code snippet appears. 

 
 

 

Hint 
This code will simply output a message to the console indicating that the request was 
approved. 

 

__32.  Press Ctrl+s to save the Java code.  Close the Java editor. 

__33.  From the Assembly Diagram editor, double-click on the Credit Report component.   
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__34.  From the Open confirmation window, click on Yes. 

 
 

__35.  Select Java as the implementation type. Click on OK. 

 
 

__36.  From the Generate Implementation window, accept the default selection, and then click on OK. 

 
 

The Java editor appears for the implementation of the CreditReport component. 
 

__37.  Scroll down to the bottom of the Java code.  Select the highlighted text below and delete. 

 

__38.  Type credrep in the line of code as shown below.  Press Ctrl+spacebar. 
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A code snippet appears. 

 
 

 

Hint 
This code will return a credit score of 449 if the Customer ID submitted in the request is 
“123”, otherwise a credit score of 501 will be returned.  A credit score below 500 will be 
considered high-risk, and a score above 500 will be considered low-risk.  In other words, 
a request with a Customer ID of “123” will be rejected, and any other Customer ID will 
be approved. 

  

__39.  Press Ctrl+s to save the Java code. Close the Java editor. 
 

__40.  From the Assembly Diagram editor, double-click on the Generate Decline component.  

  
 

__41.  From the Open confirmation window, click on Yes. 

__42.  From the Implement As window, select Java from the list, and then click on OK. 

__43.  From the Generate Implementation window, accept the default selection, and then click on OK. 
 

__44.  Scroll down to the bottom of the Java code.  Select the highlighted text below and delete. 
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__45.  Type gendec in the line of code as shown below.  Press Ctrl+spacebar. 

 
 
A code snippet appears. 

 
 

 

Hint 
This code will simply output a message to the console indicating that the request was 
denied. 

 

__46.  Press Ctrl+s to save the Java code. Close the Java editor. 

__47.  From the Assembly Diagram editor, double-click on the Credit Risk Assessment component.   

 
 

__48.  From the Open confirmation window, click on Yes. 

__49.  From the Implement As window, select Java from the list, and then click on OK. 

__50.  From the Generate Implementation window, accept the default selection, and then click on OK. 

__51.  Scroll down to the bottom of the Java code.  Select the highlighted text below and delete. 
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__52.  Type credrisk in the line of code as shown below.  Press Ctrl+spacebar. 

 
 
A code snippet appears. 

 
 

 

Hint 
This code will assign a risk assessment of “LOW” if the credit score is above 500.  
Conversely, a credit score below 500 will be assigned a risk assessment of “HIGH”. 

 

__53.  Press Ctrl+s to save the Java code. Close the Java editor. 

__54.  From the Assembly Diagram editor, press Ctrl+s to save your work.  Do not close the Assembly 
Diagram editor because this will be needed for later steps.  
 

 

Important! 
Ensure that you also pressed Ctrl+s on the Assembly Diagram editor after saving and 
closing the Java editor. 

 

The “Assemble” phase of our SOA project is now complete.   

4.5 Deploy and test the business process 

__55.  In the bottom section, click on the Problems tab.  Ensure that there are no errors listed. Warning 
messages might also appear but are acceptable at this point. 
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__56.  Click on the Servers tab.  Verify that the WebSphere Process Server v6.1 test server is 
already started. 

 

 

Hint 
This test server built into the WebSphere Integration Developer is a full instance of the 
WebSphere Process Server. 

 

__57.  Right-click on the WebSphere Process Server v6.1 test server.  From the popup menu, select 
Add and Remove Projects. 

 
 

__58.  Click on Add All.  

 
 

__59.  Click on Finish.   
 

 

What just happened? 
The SimpleAccountVerification process and all its related components were deployed to 
the WebSphere Process Server for testing. Specifically, an Enterprise Application 
module (EAR), EJB module, and other needed Web and Client modules were generated 
for the SimpleAccountVerification projects and deployed to the test server. 
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__60.  The server state will change to Publishing. You will also see a progress indicator at the bottom.  

 
 

__61.  Wait for the progress indicator at the bottom to disappear. From the Servers view, check that the 
server state has changed to Synchronized. Expand WebSphere Process Server v6.1 and check 
that the SimpleAccountVerification projects have Started. 

 
 

__62.  Right-click on WebSphere Process Server v6.1.  From the popup menu, select Launch -> 
Business Process Choreographer Explorer. 

 
 
The Business Process Choreographer Explorer appears.   
 

 

Hint 
The Business Process Choreographer Explorer is a built-in web application that provides 
a way to manage business processes and work on items associated with human tasks. 
You will use this to test the SimpleAccountVerification process. 
 
The Business Process Choreographer Explorer can also be started using a standard web 
browser at  https://localhost:9443/bpc . 

 

__63.  If a Security Alert window appears, select Yes to proceed. 

https://localhost:9443/bpc�
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__64.  Click on the My Process Templates link to display a list of processes which can be started. 

 
 

__65.  Place a checkmark beside SimpleAccountVerification. Click on Start Instance. 

 
 
 
This will start the SimpleAccountVerification process, and display the default input page. 
 

__66.  From the default input page, click on Add. 
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__67.  For the customerID field, type 123. 

 

 

Hint 
A Customer ID of 123 will result in a low credit score and a denied request.  Any other 
Customer ID value will result in an approved request.  For example, try a Customer ID 
of 789.  You will see console messages indicating that the request was approved. 

 

__68.  Click on Submit.   

__69.  After a few moments, the SimpleAccountVerification process will generate messages to the 
Console view indicating that the request is denied. 

 
 

 

Hint 
This indicates that the business process is functioning properly.  You can also try other 
input values for the customerID. A request with a customerID not equal to 123 will be 
approved. 
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4.6 Cleanup 

__70.  When you’re done testing the business process, close the Business Process Choreographer 
Explorer.  

 

 

The “Deploy” phase of our SOA project is now complete. 

 
 

   Please continue to the next lab. 
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Lab 5 Publish Service Interface for Reuse 
 

Goals: 

• Encourage reuse at the enterprise level 

• Promote standards 
 

Role:  Integration Developer 
In an earlier lab, the WebSphere Business Modeler was used to model the SimpleAccountVerification 
business process, and then generate a BPEL process based on this model.  This BPEL process was 
assembled and implemented using the WebSphere Integration Developer.  One of the tasks in the 
SimpleAccountVerification process invokes a Credit Report service.  The interface of the Credit Report 
service was based on the business model from the WebSphere Business Modeler, and will now become 
the standard interface for all credit report services used in the enterprise.  In order to promote this 
interface as an enterprise standard and enable reuse, it will be published to the WebSphere Service 
Registry and Repository. 

5.1 Publish the Credit Report Service Interface 

__1.  Select and right-click on the CreditReport Interface in the SimpleAccountVerification_lib module. 

 
 

__2.  From the popup menu, select Show Files. 

 
 

This will switch to the Physical Resources view to display the actual file in the file system. 
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Hint 
A service interface in the Business Integration view is actually a standard WSDL file in 
the file system. We need to select the WSDL file in order to publish it to the WebSphere 
Service Registry and Repository. 

 

__3.  Right-click on CreditReportInterface.wsdl. From the popup menu, select Service Registry -> 
Publish Document(s). 

 
 

__4.  Check that the selected File type is WSDL.  Click on Finish. 

 
 

__5.  Verify that the WSDL file was successfully published. Click on OK. 
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Role:  Architect 
 

 

What’s next? 
You will now switch back to the role of an architect and review the published interface 
file.  In a more realistic situation, governance will be applied and the proper 
authorization procedures will be enforced before the interface becomes an enterprise 
standard.  However, to save time in this lab, you will just review the interface file. 

 

__6.  Switch to the web browser showing the WebSphere Service Registry and Repository console. 

 

 

Troubleshooting 
If the WebSphere Service Registry and Repository console was closed, just start a web 
browser and go to http://localhost:9080/ServiceRegistry.  

 

__7.  Expand the Service Documents section. Click on WSDL Documents. 

 
 

__8.  Verify that CreditReportInterface.wsdl appears on the list. 

 
 

 

What just happened? 
You verified that the CreditReportInterface.wsdl file uploaded from the WebSphere 
Integration Developer is now contained in the WebSphere Service Registry and 
Repository.  The WSDL file can now be reused as the standard interface for both internal 
and external Credit Report services.  In a realistic environment, the Credit Report 
Interface should also be properly governed, but that will be skipped in this lab. 

 

 

http://localhost:9080/ServiceRegistry�
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  Please wait for the next lecture before proceeding to the next lab. 
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Lab 6 Explore a Web Service Endpoint 
 

Goals: 

• Explore the Internal Credit Report Web Service 
 

Role:  Web Service Developer 
 

Let’s first make several assumptions: 

 You are a web services developer for the Finance department. 

 You are working on a different machine from where the SimpleAccountVerification process is being 
assembled.   

 Your primary role is application and web services development.   

 For this particular project, you do not need to be concerned with BPEL process development. That 
has been assigned to another member of your development team. 

 This lab is not focused on the deep technical aspects of web services development.  The focus is 
more on how web services fit into SOA and BPEL projects.  In line with this, you will assume that 
you’ve already completed the web service needed by the BPEL process. 

One of the tasks of the SimpleAccountVerification process is to request a credit report. This CreditReport 
service is currently implemented as Java code.  The decision now is to change the implementation to 
invoke a web service.  You were assigned to provide an internal credit report web service, which must be 
based on a standard service interface published to the WebSphere Service Registry and Repository.  
You’ve worked diligently, and you’ve now completed the Internal Credit Report Web Service, and it is 
ready for use.  The next step is to publish the web service to the WebSphere Service Registry and 
Repository so that it can be invoked by the SimpleAccountVerification process. 

 

6.1 Import the completed web service 

__1.  Switch to the WebSphere Integration Developer. 

__2.  From the main menu, select File -> Import. 

__3.  Expand the Other category. Select Project Interchange as the import source. Click on Next. 
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__4.  Click the Browse button for the From zip file field. Select the file 
C:\PoT\BPMSOA\CreditReportServices_Internal_PI.zip.  

 
 

__5.  Click on Select All.  Click on Finish. 

 
 

You will now see two more modules in the Business Integration view. 

 

 
 

 

What just happened? 
Instead of developing the web service from the ground up, you imported two modules 
which contain the completed Credit Report web service. This was done to save time. At 
this point, just assume that you’ve just finished the development of the web service. 

 

 

What’s next? 
You will briefly explore the completed Credit Report web service, and then publish the 
web service to the WebSphere Service Registry and Repository for reuse. 
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6.2 Explore the web service artifacts 

__6.  Expand the InternalCreditReportWebService module.  Expand WebContent -> WEB-INF.  
Expand wsdl until you find the files Businessitems.xsd and CreditReportInterface.wsdl. 

 

 
 

The Businessitems.xsd and CreditReportInterface.wsdl files were imported from the WebSphere 
Service Registry and Repository at the start of the development of the web service.  The 
standard Credit Report service interface defined in the WSDL file, as well as the standard 
CustomerApplication object defined in the XSD file, were used in the web service. 

 

 

What’s next? 
You will now explore how the Businessitems.xsd and CreditReportInterface.wsdl files 
were imported from the WebSphere Service Registry and Repository 

 

__7.  Switch to the Service Registry view. 
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__8.  Right-click anywhere inside the Service Registry view. From the popup menu, select Retrieve 
WSDL documents. 

 
 

A window appears indicating that the CreditReportInterface.wsdl file was successfully retrieved. 

 
 

__9.  Click on OK. 

__10.  Right-click again anywhere inside the Service Registry view. From the popup menu, select 
Retrieve XSD documents. 

 
 

A window appears indicating that the Businessitems.xsd file was successfully retrieved. 

 

__11.  Click on OK. 

__12.  Switch to the Service Registry view. You will now see the CreditReportInterface.wsdl and 
Businessitems.xsd files retrieved from the WebSphere Service Registry and Repository.  
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From here these files were imported into the InternalCreditReportWebService module so that the 
Internal Credit Report web service can be developed based on the standard interface defined in 
the WSDL, as well as use the standard data objects defined in the XSD. 

 

 

What’s next? 
You will now publish the web service to the WebSphere Service Registry and 
Repository. The assumption is that the web service developer is using a different 
machine from the developer working on the BPEL process. You are publishing the web 
service from this machine so that it can be imported into the machine of the integration 
developer. 

 

6.3 Publish the Web Service 

__13.  Switch to the Business Integration view. 

__14.  Expand InternalCreditReportWebService. Right-click on 
InternalCreditReportWebService.wsdl. 

 

 
 

__15.  From the popup menu, select Service Registry -> Publish Document(s). 
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__16.  Ensure that the selected File type is WSDL. Click on Finish. 

 
 

__17.  A window will appear indicating that the document was successfully published. Click on OK. 

6.4 Check the WebSphere Service Registry and Repository 

__18.  Switch to the web browser showing the WebSphere Service Registry and Repository console. 

 

 

Troubleshooting 
If the WebSphere Service Registry and Repository console was closed, just start a web 
browser and go to http://localhost:9080/ServiceRegistry.  

 

__19.  Select GP Developer from the perspective list. Click on Go. 

 
 

__20.  Expand the Service Documents section. Click on WSDL Documents. 

 
 

__21.  Verify that InternalCreditReportWebService.wsdl appears on the list.  (Do not click) 

 

http://localhost:9080/ServiceRegistry�
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__22.  Click on the Graph button for the InternalCreditReportWebService.wsdl. 

 
 

After a few moments, a graphical view appears showing the different relationships involving 
InternalCreditReportWebService.wsdl. 

 

__23.  Maximize the web browser. Review the graph. 

 
Notice that the web service is based on the standard interface. 

 

__24.  Partially scroll to the right of the diagram. 

 
The web service also uses the standard business objects. 
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__25.  Scroll to the right of the diagram again. 

 
 

The graph also shows the service operation and input/output objects. 

 

 

 

What’s next? 
The InternalCreditReportWebService.wsdl file can now be reused and imported into the 
development machine where the SimpleAccountVerification process is being developed. 

 

 

 

   Please continue to the next lab. 
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Lab 7 Change Service Implementation 
 

Goals: 

• Respond to changing business needs 

• Take advantage of IT flexibility provided by infrastructure 

• Quickly change implementation of business tasks 
 

Role:  Integration Developer 
Let’s first make several assumptions: 

 You are back to being an integration developer. 

 Another member of your development team has just completed the Internal Credit Report web 
service, and has made it available for use. 

 You are working on a different machine from where the Internal Credit Report web service was 
developed. 

To illustrate the IT flexibility needed for business flexibility, you will change the implementation of one of 
the tasks without major effort.  By applying the loose-coupling and building block approach, switching to 
a different application or system becomes easier and quicker.  This is true even if the new system 
involves a different technology, programming language, and runtime environment.  This approach allows 
business processes to be more responsive to changes in their business environment, such as being able 
to quickly adapt to customer demands, exploit new market opportunities, or react to competitive threats.   

In our simple scenario, let’s assume that the Credit Report task now needs to invoke an existing system 
exposed as a web service.  You will now change the implementation type of this task from Java code to a 
web service invocation.  The web service is really just an example in this exercise.  Instead of a web 
service, you can just as easily switch the Credit Report task to a human task, business rule, business 
process, messaging-based application, back-end system exposed through adapters, etc. 

 

7.1 Import the web service WSDL from the WebSphere Service Registry 
and Repository 

__1.  Switch to the WebSphere Integration Developer. 
 

 

What’s next? 
You will need to import the WSDL file for the Internal Credit Report web service so that 
it can be used by the process.  This WSDL file was published earlier by the web service 
developer to the WebSphere Service Registry and Repository. 
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__2.  Switch to the Service Registry view. 

 
 

__3.  Right-click anywhere inside the Service Registry view. From the popup menu, select Retrieve 
WSDL documents. 

 
 

A window appears indicating that the InternalCreditReportWebService.wsdl file was successfully 
retrieved. 

 
 

__4.  Click on OK. 

__5.  Switch to the Service Registry view. Expand WSDL Documents. Right-click on 
InternalCreditReportWebService.wsdl. 

 
 

__6.  From the popup menu, select Import Document. 

 
 

__7.  Select SimpleAccountVerification_lib.  Click on Finish. 
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__8.  Switch to the Business Integration view.  Verify that the InternalCreditReportWebService now 
appears under Web Service Ports, and is ready for use. 

 
 

 

What just happened? 
You imported the InternalCreditReportWebService.wsdl file published by the web 
service developer and this web service can now be invoked by the BPEL process. 

 

7.2 Change the Credit Report task to a Web Service Implementation 

__9.  From the Assembly Diagram editor, select the CreditReport component on the right. Press the 
delete key. 

 



IBM   

Page 88 SOA PoT  

__10.  Using the left mouse button, drag and drop InternalCreditReportWebServicePort into an 
empty space in the Assembly Diagram editor. 

 
 

__11.  Select Import with Web Service Binding. Click on OK. 

 
 
 
A CreditReport Web Service component will appear in the Assembly Diagram editor. 
 

 

__12.  From the palette on the left, select the Wire icon. 
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This will switch the editor to ‘wire’ mode, which will make it easier to connect components in the 
Assembly Diagram editor. 

__13.  Left-click on the CreditReport export component.  This will start a connection (blue line). 

 
 

 

Hint 
An export component defines how the service implementation can be accessed by others.  
Specifically in the diagram above, the Credit Report Import on the right represents the 
implementation or service endpoint.  The Credit Report Export on the left defines how 
other external components can access the Credit Report Service. 

 

__14.  Click on the CreditReportImport1 component.   

__15.  A prompt window will appear. Select the Always create without prompt option. Click on OK. 

 
 

This will complete the connection. 

 

__16.  From the Palette, click on the Selection Tool icon to switch back to selection mode. 
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__17.  Right-click on an empty space in the Assembly Diagram editor.  From the popup menu, select 
Layout Contents. 

 
 
This will rearrange the CreditReportImport1 component for a cleaner layout. 

__18.  Press Ctrl+s to save the modified assembly. Do not close the Assembly Diagram editor. 

 

7.3 Retest the SimpleAccountVerification Process 

__19.  Switch to the Servers view. 

__20.  Right-click on the WebSphere Process Server v6.1.  From the popup menu, select Add and 
Remove Projects. 

 
 

__21.  From the Add and Remove Projects window, click on Add All.    
This will add the project to the list of projects that will be deployed to the test server. 

 
 

__22.  Click on Finish. 

__23.  The server state will change to Publishing. You will also see a progress indicator at the bottom.  
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__24.  Wait for the progress indicator at the bottom to disappear. From the Servers view, check that the 
server state has changed to Synchronized. 

 
 

__25.  From the Servers view, expand WebSphere Process Server v6.1.   

 

__26.  Right-click on WebSphere Process Server v6.1.  From the popup menu, select Launch -> 
Business Process Choreographer Explorer. 

 
 
 
The Business Process Choreographer Explorer appears.   
 

__27.  Click on the My Process Templates link to display a list of processes which can be started. 

 
 

__28.  Place a checkmark beside SimpleAccountVerification. Click on Start Instance. 

 
 
 
This will start the SimpleAccountVerification process, and display the default input page. 
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__29.  From the default input page, click on Add. 

 
 

__30.  For the customerID field, type 123. 

 
 

 

Hint 
A Customer ID of “123” will result in a low credit score and a denied request.  Any other 
Customer ID value will result in an approved request. 

 

__31.  Click on Submit.   

 

__32.  After a few moments, the SimpleAccountVerification process will generate messages to the 
Console view indicating that the request is denied. 
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__33.  Verify that a web service is now invoked instead of the previous Java code. 

 
  

 

What just happened? 
You’ve just made a significant change to the implementation of the Credit Report 
Service with no coding and minimal steps (steps 30-39). 

 

7.4 Cleanup 

__34.  When you’re done testing the process, close the Business Process Choreographer Explorer.  

 
 

 

  Please wait for the next lecture before proceeding to the next lab. 



IBM   

Page 94 SOA PoT  

Lab 8 Externalize Business Rules 
 

Goals: 

• Achieve business agility 

• Allow changes to business rules at runtime 

o No recoding, retesting, and redeploying 
 

Role:  Integration Developer 
Changes in your business environment often involve the need to adjust business variables such as 
discount rates, fees, or product pricing based on promotions, time of year, etc.  It might also involve 
modifications to business algorithms or decision tables.  Business processes need to be able to quickly 
adapt to these changes, without time, cost, and resource-intensive development and maintenance work.   

 

The Business Rules capability of the WebSphere Process Server can provide that type of business 
flexibility, where business variables and formulas can be loosely-coupled or externalized from the 
business processes.  This feature enables quick and easy modifications to business rules without 
recoding or redeployment. 

 

The Business Rules feature of the WebSphere Process Server also adheres to the building-block 
approach, where these business rules are modularized and treated just like any other service 
component.  This will be illustrated in this lab where you will quickly change the Credit Risk Assessment 
task from Java code to Business Rules. 

8.1 Change the Credit Risk Assessment Task to a Business Rule 

__1.  From the Assembly Diagram editor, right-click on the CreditRiskAssessment component on 
the right side. 
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__2.  From the popup menu, select Change Type -> Rule Group. 

 
 
This will change the implementation type from Java to a Rule Group.  The logic to determine 
whether the risk assessment rating is HIGH or LOW, is currently in Java code.  It will now be 
replaced by a Business Rule for better flexibility. 

 

__3.  Double-click on the CreditRiskAssessment component.   

 
 

__4.  From the prompt window, click on Yes. 

 
 
An empty Business Rule Group will be created.  The next step is to define the specific rules to 
determine if the credit risk assessment rating should either be HIGH or LOW based on the credit 
score. 

 

__5.  From the Generate Implementation window, accept the default selection, and then click on OK. 

 
 
The Business Rule Group editor appears. 
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8.2 Define the Business Rule Set 

__6.  From the Rule Group editor, click on the InputCriterion Interface. 

 
 
A Rule Group contains related Business Rules.  In other words, a Rule Group is a logical 
grouping of related Rules.   

__7.  Click on the Enter Rule Logic link. 

 
 

__8.  Select New rule set from the popup list. 

 
 

__9.  From the New Rule Set window, accept the defaults, and then click on Finish. 
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__10.  From the Rule Set editor, click on the Add If Then Template icon in the Templates section. 

 
 

 

What’s next? 
The next step is to define a business rule where the risk assessment will be rated “HIGH” 
if the credit score from the CreditReport web service is less than a certain threshold.  In 
the previous Java implementation, the threshold was fixed at 500.  In this business rule, 
it will be a variable that can be changed at runtime. 

 

__11.  In the Templates section, click on the Add Template Parameter icon. 

 
 

__12.  Change the Parameter Name from param1 to threshold. 

 
 

__13.  Click on the Select Type link. 
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__14.  From the popup list, select int. 

 
 
 
Take note of the red ‘x’ marks ( ) highlighted below.  This indicates that errors exist in those 
fields.  That is to be expected at this point because the proper values still have to be specified. 
 

 
 

__15.  Click on the Condition link in the If field. 

 

__16.  Ignore the popup list and just type the following into the If field: 

          Input.creditScore<threshold 
 

 
 
The red ‘x’ mark ( ) beside the If field should disappear if the Condition value was specified 
correctly. 

__17.  Click on the Action link in the Then field. 
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__18.  Ignore the popup list and type the following into the Then field: 

          Output.creditRiskAssessment=”HIGH” 
 

 
 
The red ‘x’ mark ( ) beside the Then field should disappear if the Condition value was specified 
correctly. 

__19.  Type the following into the Presentation field: 

          If credit score is less than {threshold} then risk assessment is HIGH 
 

 
 
 

 

Hint 
The text specified in the Presentation field will be displayed in the Business Rules 
Manager user interface.  The Business Rules Manager will allow you to dynamically 
change the parameter values in the template rule while the process is running.  In this 
case, the threshold parameter can be changed at runtime to affect how the risk 
assessment rating is determined, without having to modify, retest, and redeploy the 
process.  This will be illustrated later in the lab. 

 

__20.  In the Rules section, click on the Add Action Rule icon. 

 
  

__21.  Click on the Action link in the Action field. 
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In the previous steps, you ignored the popup list which appeared when a field link was clicked to 
keep the steps simple.  However, the popup lists can also be very useful in supplying the proper 
values for the fields.  Let’s try it in the next step. 

 

__22.  From the popup list, select Output : CustomerApplication.  (Output is a property from the Rule 
Set Interface, and CustomerApplication is the property type.) 

 
 

__23.  From the popup list, select the ‘=’ operation. 

 
 

__24.  From the popup list, select Input : CustomerApplication.   

 
 

The Action field should now look similar to this : 

  
 

 

Hint 
This will copy the contents of the Input variable to the Output variable.  The Input 
variable is a parameter passed into this Rule Set when invoked.  The Output variable will 
be passed back to the component invoking this Rule when execution is complete. 

 

__25.  While the cursor is still in the Action field, press the Enter key. This will add another Action link. 
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__26.  Ignore the popup list again and type the following into the second line of the Action field: 

          Output.creditRiskAssessment=”LOW”  
 

 
 

__27.  Click on the Add Template Rule icon in the Rules section. 

 

__28.  From the popup list, select Template 1. 

 
 
This will create an empty Rule based on the Rule Template created earlier. 

 

__29.  Specify a value of 500 for the threshold variable in the Presentation field. 

 
 
The Business Rule is now complete. This Rule Set basically recreates the logic in the previous 
Java implementation where the risk assessment will be HIGH if the credit score is less than the 
current threshold level of 500.  The significant difference is that this was done without any 
programming, and the threshold value can be changed dynamically at runtime. 

 

 

Important! 

There should no longer be any red ‘x’ marks (  ). 
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8.3 Save and Verify the Business Rule 

__30.  Press Ctrl+s to save the Rule Set.   

__31.  Close the InputCriterion Rule Set editor.   

 
Focus should return to the CreditRiskAssement Business Rule Group. 
 

 
 

__32.  Press Ctrl+s to save the Rule Group.   

__33.  Close the CreditRiskAssement Rule Group editor.   

Focus should return to the Assembly Diagram editor. 

 

__34.  From the Assembly Diagram editor, press Ctrl+s to save the modified assembly. Do not close 
the Assembly Diagram editor. 

 

__35.  Switch to the Problems view.  Verify that no errors exist (messages with a red ‘x’ mark ).  
Warnings messages are expected. 

 

8.4 Retest the SimpleAccountVerification Process 

__36.  Switch to the Servers view. 

The WebSphere Process Server should now have a state of Republish. 

 
 

__37.  Right-click on WebSphere Process Server v6.1.  From the popup menu, select Publish. 
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__38.  Wait for the progress indicator window to disappear. 

 
 

__39.  Verify that the state of the WebSphere Process Server is now Synchronized. 

 
 

__40.  Right-click on WebSphere Process Server v6.1.  From the popup menu, select Launch -> 
Business Process Choreographer Explorer. 

 
 
The Business Process Choreographer Explorer appears.   

__41.  Click on the My Process Templates link to display a list of processes which can be started. 

 
 

__42.  Place a checkmark beside SimpleAccountVerification. Click on Start Instance. 

 
 
This will start the SimpleAccountVerification process, and display the default input page. 
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__43.  From the default input page, click on Add. 

 
 

__44.  For the customerID field, type 123. 

 
 

 

Hint 
A Customer ID of “123” will result in a low credit score and a denied request.  Any other 
Customer ID value will result in an approved request. 

 

__45.  Click on Submit.   

After a few moments, the SimpleAccountVerification process will generate messages to the 
Console view. 
 

__46.  Verify that the request is denied. 

 
 

A Customer ID of “123” again resulted in a low credit score and a denied request.  The difference 
in this case is that a Business Rule was used instead of Java code.  The Business Rule 
determined that the credit risk assessment was LOW because the credit score was below the 
current threshold of 500.  
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What’s next? 
Because the credit risk assessment is now implemented as a Business Rule, the next few 
steps will illustrate how this provides greater business agility. 

 

__47.  Close the Business Process Choreographer Explorer. 

 
 

8.5 Modify the Credit Assessment Business Rule at Runtime 

__48.  Click on a web browser icon in the Quick Launch bar.   

  or   
 

__49.  From the web browser window, open the URL http://localhost:9080/br . 
The Business Rules Manager user interface appears. 

 

 

Hint 
The Business Rules Manager UI can also be used inside the WebSphere Integration 
Developer.  Just follow these steps: 

 Switch to the Servers view. Right-click on WebSphere Process Server v6.1. 
 From the popup menu, select Launch -> Business Rules Manager. 

 

Using a standard web browser, an authorized person such as a manager or business analyst, 
can dynamically change the behavior of the business process at runtime by modifying the 
externalized business rules. 
 

__50.  From the Rule Books tree view on the left, click on the lowest InputCriterion. 

 

https://localhost:9080/br/�
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Hint 
The logon window did not appear because security is disabled in the test server.  In a 
secure production environment, users will be required to log in and business rules can 
only be accessed by authorized users. 

 

__51.  From the InputCriterion - Rule Set pane, click on Edit. 

 
 

 

What’s next? 
This is the rule set for the Credit Risk Assessment Business Rule.  The current threshold 
of 500 will be lowered so that the request of Customer ID 123 will be accepted. 

 

__52.  From the Rule set editor, change the threshold value to 300. 

 
 

__53.  Click on Save.   

__54.  Click on the Publish and Revert link. 
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A list appears showing Business Rules Resources that were changed. You can either revert the 
changes back to its original state, or publish the changes. 
 

__55.  Ensure that InputCriterion is selected. 

 
 

__56.  Click on Publish. 

 
 
The Messages box should indicate that the rule change was published successfully. 
 

 
 

__57.  Switch to the WebSphere Integration Developer. 

__58.  Right-click on WebSphere Process Server v6.1.  From the popup menu, select Launch -> 
Business Process Choreographer Explorer. 

 
 

__59.  Click on the My Process Templates link to display a list of processes which can be started. 
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__60.  Place a checkmark beside SimpleAccountVerification. Click on Start Instance. 

 
  

__61.  From the default input page, click on Add. 

__62.  For the customerID field, type 123. 

 
 

__63.  Click on Submit.   

__64.  After a few moments, the SimpleAccountVerification process will generate messages to the 
Console view indicating that the request is now approved. 

__65.  Verify that the request has been approved. 

 
 

A Customer ID of “123” now resulted in an accepted request because the threshold level in the 
Credit Risk Assessment Business Rule was lowered to 300.  Significant cost reductions can 
result from this type of business and IT flexibility. 
 

 

What’s next? 
The threshold variable of the business rule will be reset to its original value of 500. 
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8.6 Reset the Credit Risk Assessment Business Rule 

__66.  Close the Business Process Choreographer Explorer.  

 
 

__67.  Switch to the web browser with the Business Rules Manager web page. 

__68.  From the Rule Books tree view on the left, click on the lowest InputCriterion. 

 
 

__69.  From the InputCriterion - Rule Set pane, click on Edit. 

 
 

__70.  From the Rule Set editor, change the threshold value to 500.  

 
 

__71.  Click on Save.   
 

__72.  Click on the Publish and Revert link. 

 
 

A list appears showing Business Rules Resources that were changed. You can either revert the 
changes back to its original state, or publish the changes. 
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__73.  Ensure that InputCriterion is selected. 

 
 

__74.  Click on Publish. 

 
 
The Messages box should indicate that the rule change was published successfully. 
 

 
 

__75.  Close the web browser with the Business Rules Manager page. 

 

 

  Please wait for the next lecture before proceeding to the next lab. 
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Lab 9 Modify the Process Choreography 
 

Goals: 

• Add a task to the BPEL process  
 

Role:  Integration Developer 
The SimpleAccountVerification BPEL process will be modified to add a new task called Generate 
Acceptance.  The Generate Acceptance task is being added simply to display output from the Pricing 
and Approval human task.  This will also help introduce BPEL development. 

9.1 Define the Interface for the new ‘Generate Acceptance’ task 

__1.  From the Business Integration tree view, in the SimpleAccountVerification_lib module, right-
click on Interfaces.  From the popup menu, select New -> Interface. 

 
 

__2.  Click on the Browse button for the Folder field. 

 
 

__3.  Select the simpleaccountverification folder.  Click on OK. 
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__4.  Specify GenerateAcceptance for the Name. Click on Finish. 

 
 

__5.  From the Interface editor, click the Add Request Response Operation icon. 

 
 

__6.  Specify generateAcceptance as the operation name. 

 
 

__7.  Click on the string link for input1.   

 
 

 

What’s next? 
When the generateAcceptance operation is invoked, a parameter variable named input1 
will be passed.  By default, the parameter input1 is defined as a string type.  This will 
need to be changed to use the CustomerApplication object type instead. 

__8.  From the popup list, select CustomerApplication. 
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__9.  Change also the type of output1 to CustomerApplication.  

 
 

 

What’s next? 
During execution, when the generateAcceptance operation has completed, a result 
variable named output1 will be passed back to the calling component. 

 

__10.  Press Ctrl+s to save the new Interface. 

__11.  Close the GenerateAcceptance Interface editor. 

 

9.2 Add the GenerateAcceptance Task to the SimpleAccountVerification 
BPEL Process 

__12.  In the SimpleAccountVerification main module, double-click on Assembly Diagram. 

 
 

This will open the main assembly diagram containing the BPEL process. 

 

__13.  From the Assembly Diagram editor, double-click on the SimpleAccountVerification 
component. 
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The SimpleAccountVerification BPEL editor will appear. 

 
This is the BPEL process based on the SimpleAccountVerification business model developed 
earlier using the WebSphere Business Modeler. 
 

__14.  Right-click on an empty space in the BPEL editor.  From the popup menu, select Align Parallel 
Activities Contents Automatically. 

 
 
This option will make the editor automatically adjust the BPEL diagram to the optimum layout. 

__15.  From the SimpleAccountVerification_lib module, and using the left mouse button, drag and drop 
the GenerateAcceptance Interface to an empty space in the BPEL editor. 
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__16.  Verify that the GenerateAcceptance Interface was added to the list of Reference Partners. It 
can now be used by any task or activity in the BPEL process.  

 

 
 

 

Hint 
A Reference Partner is a soft link to the actual service endpoint.  This is how the 
WebSphere Integration Developer enables loose-coupling between the BPEL process 
and the implementation of its activities.  The developer is not forced to specify that the 
Credit Report task is a web service or some specific implementation type.  This is done 
outside of the BPEL process and in the assembly diagram.  This provides the flexibility 
needed to easily make changes. 

 

__17.  From the Activity Palette of the BPEL editor, click on the Invoke icon. 

 
 

This will load the cursor with the Invoke activity and can then be dropped on BPEL diagram. 
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__18.  Click on an empty space inside the SimpleAccountVerification flow. 

 
 
 
This will add a new Invoke activity to the BPEL diagram. 

 
 

__19.  Change the name of the new Invoke activity to Generate Acceptance. 

 
 

__20.  Select the link between the Pricing and Approval activity and the 
SimpleAccountVerificationReply activity. Press the Delete key. 
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__21.  Right-click on the Pricing and Approval activity.   

 

__22.  From the popup menu, select Add Link.  This will start a connection. 

__23.  Click on the Generate Acceptance activity to complete the connection. 

 
 

__24.  Right-click on the Generate Acceptance activity.   

 

__25.  From the popup menu, select Add Link. 

__26.  Click on the SimpleAccountVerificationReply activity to complete the connection. 

__27.  Verify that the SimpleAccountVerification process looks similar to the screenshot below. 

 
 

 

Troubleshooting 
If needed, press Ctrl+z or select Edit -> Undo to undo your changes. 
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__28.  Right-click on the Generate Acceptance activity.  From the popup menu, select Set Partner. 

__29.  From the Select a Partner window, select GenerateAcceptance. Click on OK. 

 
 

__30.  Right-click again on the Generate Acceptance activity.  

__31.  From the popup menu, select Show in Properties. This will display the Properties view for the 
Generate Acceptance activity in the bottom of the screen. 

__32.  Click on the Details tab. 

 
 

__33.  Click on the More ( ) button for the Input field. 

 
 

__34.  Ensure that CustomerApplicationVariable is selected. Click on OK. 

 
 

This will specify the CustomerApplicationVariable for the Input. 

__35.  Perform the same steps to also specify CustomerApplicationVariable for the Output. 
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What just happened? 
You configured the GenerateAcceptance activity to use the CustomerApplication 
business object for both input and output. 

__36.  Right-click on the SimpleAccountVerificationReply activity.   

__37.  From the popup menu, select Show in Properties. 

__38.  From the Properties view, select the Join tab. 

 

__39.  Select the Visual option for the Expression Type.   

__40.  From the Question window, click on Yes. 

 
 
The Visual Snippet Editor appears which allows you to implement logic or expressions without 
having to know Java programming. 
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Hint 
The default expression in the Visual Snippet Editor simply indicates that a boolean value 
of true will be returned to the caller of the SimpleAccountVerification process.  At this 
point, no changes are necessary. 

 

__41.  Press Ctrl+s to save the changes to the BPEL process. 

__42.  Close the SimpleAccountVerification BPEL editor.   

 

 

Hint 
Notice that as you were developing the BPEL process, the actual implementations for the 
tasks in the process were never specified.  You only associated the tasks to references to 
external implementations.  This provides the loose-coupling characteristic needed for 
effective integration.  The actual implementations are defined externally using the 
Assembly Diagram editor.  This approach also provides a level of abstraction to 
components such as the BPEL process for greater IT flexibility. 

 

 

What just happened? 
The Generate Acceptance activity was added to the flow of the 
SimpleAccountVerification process.  However this activity has not yet been linked to its 
implementation.  Only a soft link was specified.  The hard link will be specified next. 

 

9.3 Add the implementation for the new Generate Acceptance task 
 

__43.  From the Assembly Diagram editor, right-click on the SimpleAccountVerification component.   

 
 

__44.  From the popup menu, select Synchronize Interfaces and References -> from 
Implementation. 

 
 



IBM   

SOA PoT – Lab handouts, Part 1 Page 121 

__45.  From the confirmation window, click Yes. 

 

 

What just happened? 
This changed the assembly diagram to reflect the new task added to the BPEL process.  
A new reference point was added to the right of the BPEL process component for the 
Generate Acceptance activity.  This also fixed the mismatch error and removed the red 
‘x’ mark ( ) on the SimpleAccountVerification component. 

 

 
 

 

What’s next? 
The next step is to create an implementation for the Generate Acceptance activity.  This 
will be done in the implementation module.  You will then export this implementation to 
the BPEL process assembly diagram in the main module.  The exported implementation 
will then be linked to the Generate Acceptance reference point. 

 

__46.  Switch to the Assembly Diagram editor for the implementation module. 

 
 

__47.  Right-click on an empty space in the canvas. From the popup menu, select Arrange Contents 
Automatically. 

 
 

__48.  From the Palette on the left, select the Java component. 
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__49.  Click on an empty space in the canvas to drop the Java component. 

The Java component appears in the canvas. 

 
 

__50.  Single-click on the new Java component to edit the name.  Change the name to 
GenerateAcceptance. 

 
 

 

Hint 
To rename the Java component, you can also right-click on the component, and then 
select Rename from the popup menu. 

 

__51.  Click on the Add Interface icon displayed above the component.  

 
 

 

Troubleshooting 
If the Add Interface icon is not displayed, right-click on the GenerateAcceptance 
component, and then select Add -> Interface from the popup menu. 

 

__52.  Specify the text Generate as the Filter criteria, and then select GenerateAcceptance from the 
matching interfaces list. 
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__53.  Click on OK. 

 

 

What just happened? 
The newly added Java component can now be invoked using the operations and 
input/output objects defined in the GenerateAcceptance interface.  Code will also be 
generated based on this added interface. 

 

__54.  Right-click on the GenerateAcceptance Java component.   

 
 

__55.  From the popup menu, select Refactor -> Move. 

__56.  From the prompt window, click on OK to save the assembly diagram before refactoring. 

 
 

__57.  From the container list, expand SimpleAccountVerification_impl to select 
simpleaccountverification. 

 
 

__58.  Click on OK to indicate that the GenerateAcceptance Java component will be created in the 
selected folder. 

 

__59.  Double-click on the GenerateAcceptance component.   
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__60.  From the Open confirmation window, click on Yes. 

 
 

__61.  From the Generate Implementation window, accept the default selection, and then click on OK. 

  
 
The Java editor appears for the implementation of the GenerateAcceptance component. 
 

__62.  Scroll down to the bottom of the Java code.  Select the highlighted text below and delete. 

 
 

 

Troubleshooting 
If you don’t find the code displayed above, then the steps which should have added the 
GenerateAcceptance interface might have been skipped. 

 

__63.  Type genacc in the line of code as shown below.  Press Ctrl+spacebar. 

 
 
The Ctrl+spacebar key combination activates a special feature called Code-Assist.  This will 
add the required code snippet for you.   
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Hint 
This code will display a confirmation that the request is approved, as well as the Pricing 
Plan output from the Pricing and Approval human task.  The Pricing and Approval 
human task will be implemented in the next lab. 

 

__64.  Press Ctrl+s to save the Java code.  Close the Java editor. 
 

 

What’s next? 
You have just completed the implementation of the Generate Acceptance service.  You 
now need to make this component available to other modules, such as the main module 
with the BPEL process.  To expose this service component, you will need to generate an 
Export component.   
 
You will also need to select an export binding.  While interfaces are abstract definitions, 
bindings are concrete definitions. They specify the physical mechanism that service 
requesters can use to access the service.  There are different bindings to choose from, 
such as an HTTP Binding, Messaging Binding or Web Service Binding.  For the 
Generate Acceptance service, you will select the SCA Binding, which allows interaction 
between different modules. 

 

__65.  Right-click on the GenerateAcceptance Java component.   
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__66.  From the popup menu, select Generate Export -> SCA Binding. 

 
 

 

Hint 
An SCA Binding will allow other modules, specifically the main BPEL module, to 
access the Generate Acceptance service component. 

 

An Export component will be generated. 

 
 

__67.  Press Ctrl+s to save the changes. 

__68.  Switch to the Assembly Diagram for the main module. 

 
 

__69.  From the Palette, select the Import component. 

 
 

__70.  Click on an empty space in the canvas to drop the Import component. 

 
 

__71.  Single-click on the Import component to edit the name.  Change the name to 
GenerateAcceptance. 
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__72.  From the palette, click on the Wire button. 

   
 

__73.  Click on the new GenerateAcceptance reference point on the SimpleAccountVerification 
process component.  This will start a connection or wiring. 

 
 

__74.  Click on the GenerateAcceptance import component.  This will complete the new connection. 

 
 

__75.  From the palette, click on the Selection Tool button.  

 
  

__76.  Right-click on the GenerateAcceptance component.    

 
 

__77.  From the popup menu, select Generate Binding -> SCA Binding. 
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__78.  Right-click again on the GenerateAcceptance component.  

 
 

__79.  From the popup menu, select Select Service to Import. 
 

__80.  Select GenerateAcceptanceExport from the list. Click on OK. 

 
 

__81.  Press Ctrl+s to save the assembly diagram. 

The warning symbol ( ) on the reference point should now disappear. 

 

 

What just happened? 
The implementation of the GenerateAcceptance service was created in the 
implementation module.  You then imported the GenerateAcceptance service into the 
main module, and linked it to the Generate Acceptance activity in the BPEL process. 

 

 

 

   Please continue to the next lab. 
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Lab 10 Incorporate Human Tasks 
 

Goals: 

• Integrate business processes end-to-end 

• Include human tasks with automated business processes 

o Assign the right work to the right people at the right time 

o Human task must be repeatable, reusable, auditable 
 

Role:  Integration Developer 
Business processes often involve human intervention, such as a loan officer reviewing loan applications, 
or a manager approving employee reimbursements.  There will always be situations where systems or 
programs cannot automatically make decisions based on the available information.  A business process 
might also involve a trivial task such as a secretary manually sending fax requests to print promotion 
materials.   Because the goal is to implement the entire process end-to-end, then manual tasks need to 
be included with the automated tasks.  With IBM’s SOA Foundation and the WebSphere Business 
Process Management software portfolio, human activities are fully supported in business processes.  In 
fact, the human task capabilities in the WebSphere Process Server are also designed for loose-coupling, 
effective reuse, and the building-block approach. 
 
In this section, the implementation type for the Pricing and Approval task will be converted from Java to a 
human task.  It has been decided that this final approval task now requires manual intervention.  You will 
also allow the BPEL process to be invoked by a human task. 

 

10.1 Create a Human Task to start the process 

__1.  Double-click on the SimpleAccountVerification process. 

 
 

__2.  Right-click on the SimpleAccountVerificationReceive activity. 
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__3.  From the popup menu, select Show in Properties. 

__4.  From the Properties view, click on the Authorization tab. 

 
 

__5.  Click on New. 

 
 

The Human Task editor appears. 

 

__6.  Close the Human Task editor.  At this point, we do not need to make any changes to the Human 

Task configuration.   

 

 

What just happened? 
A Human Task called SimpleAccountVerificationTask1 was defined for the Receive 
component in the BPEL process.  This will allow the BPEL process to be invoked by a 
Human Task.   

 

__7.  From the SimpleAccountVerification BPEL editor, press Ctrl+s to save your work. 

__8.  Close the SimpleAccountVerification BPEL editor.   
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__9.  Close the Assembly Diagram editor for the main module with the BPEL process. 

 
 

10.2 Convert the Pricing and Approval Java component to a Human Task 

__10.  From the SimpleAccountVerification_impl assembly diagram editor, right-click on the 
PricingandApproval component on the right-side. 

 

__11.  From the popup menu, select Change Type -> Human Task. 

 
 

__12.  Double-click on the PricingandApproval component, which is now a Human Task. 

 
 

__13.  From the Open confirmation window, click on Yes. 

 
 

__14.  From the Generate Implementation window, ensure that SimpleAccountVerification_impl is 
selected.  Click on OK. 
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__15.  From the Human Task Component Handler window, change the name to 
PricingandApprovalHumanTask. Click on OK. 

 
 

The Human Task editor will appear. 
 

 
 

__16.  Close the Human Task editor.  At this point, we do not need to make any changes to the Human 
Task configuration. 

__17.  From the Assembly Diagram editor, press Ctrl+s to save your work. 

 

 

What’s next? 
You will now create the user interfaces or clients for the two human tasks you just 
defined.  One web client for the human task to start the process,  and another web client 
for the Pricing and Approval human task. 

 

10.3 Generate a web client for the Start Process Human Task 

__18.  From the Business Integration tree view, right-click on SimpleAccountVerification.   
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__19.  From the popup menu, select Generate User Interfaces. 

__20.  From the User Interface Wizard for Human Tasks window, select JSF custom client as the 
client generator type. 

 
 

 

Hint 
If you noticed, there are also other client generator types available.  You can also choose 
to generate a Lotus® Forms client or a portlet.  For this lab, we will use a Java Server 
Faces (JSF) client for the human tasks. 

 

__21.  Click on Next. 

__22.  On the next window, specify the following.   

 
Name of dynamic web project:   StartProcess 
 Style selection:    Cool Blue Style 
 

 
 

__23.  Click on Finish.  Wait for the client generation operation to complete. 
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__24.  From the Client generation completed information window, click on OK. 

 
 

 

What just happened? 
A standard web page was generated to allow a person to start the 
SimpleAccountVerification process.  The web page and all its related artifacts will be 
packaged into its own J2EE project so that it can be deployed as a separate web 
application. 

 

10.4 Generate a web client for the Pricing and Approval Human Task 

__25.  From the Business Integration tree view, right-click on SimpleAccountVerification_impl.   

  
 

__26.  From the popup menu, select Generate User Interfaces. 

__27.  From the User Interface Wizard for Human Tasks window, select JSF custom client as the 
client generator type. 

 
 

__28.  Click on Next. 

__29.  On the next window, specify the following.   

 
Name of dynamic web project:   PricingandApproval 
 Style selection:    Cool Blue Style 
 

__30.  Click on Finish.  Wait for the client generation operation to complete. 
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__31.  From the Client generation completed information window, click on OK. 

 

 

What just happened? 
A standard web page was generated to allow a person to perform the Pricing and 
Approval task.  This web client will allow the person to claim and then complete the 
related work item.  When completed, control will transfer back to the BPEL process. 

10.5 Retest the SimpleAccountVerification process 

__32.  Switch to the Servers view. 

__33.  Right-click on WebSphere Process Server v6.1.  From the popup menu, select Add and 
Remove projects. 

__34.  From the Add and Remove Projects window, click on Add All.  
 

 

Hint 
Take note of the two new projects: PricingandApprovalEAR and StartProcessEAR.  
These contain the generated Human Task web interfaces. 

 

__35.  Click on Finish.   

__36.  The server state will change to Publishing. You will also see a progress indicator at the bottom.  

 
 

__37.  Wait for the progress indicator at the bottom to disappear. From the Servers view, check that the 
server state has changed to Synchronized. 

 
 

 

What’s next? 
Its time to test the two new human tasks and the added Generate Acceptance activity.  In 
the previous labs, you used the Business Process Choreographer explorer to start and test 
the process.  This time a human task will be used to start the process.  You will also use 
a human task to perform the Pricing and Approval activity instead of code. 
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10.6 Use the Human Task client to start the process 

__38.  Click on a web browser icon in the Quick Launch bar.   

  or   
 

__39.  From the web browser, open the URL http://localhost:9080/StartProcess . 

__40.  From the Business User Client web page, click on New. 

 
 

__41.  Click on SimpleAccountVerification_InputCriterion. 

 
 

__42.  For the customerID field, type 111, and then click on Create.   

 
 

 

Hint 
If we specified a customer ID of 123, the process flow would follow the ‘denied’ 
execution path.  However, you need to specify any customer ID other than 123 so that 
the request will be approved, and the flow will go through the ‘approved’ path which 
includes the modified Pricing And Approval human task and the new Generate 
Acceptance activity. 

 

__43.  Switch to the WebSphere Integration Developer. Switch to the Console view. 

https://localhost:9080/br/�
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__44.  Verify that a credit score of 501 is displayed, and that no decision has been made yet on whether 
the request is approved or denied. 

 
  

 

What’s next? 
When the Credit Score is displayed in the console, the execution of the process has 
paused.  This indicates that the process has reached the Pricing and Approval task and is 
waiting for a response from a ‘human’.  In the next steps, you will assume the role of a 
Loan Officer or Credit Manager, and perform the Pricing and Approval task.   
 
While the process is in a suspended state waiting for the human task to complete, you 
will also use some of the features of the WebSphere Integration Developer to analyze the 
execution flow and the process state. 

 

10.7 View the Process State 

__45.  Switch to the Servers view. 

__46.  Right-click on WebSphere Process Server v6.1.  From the popup menu, select Launch -> 
Business Process Choreographer Explorer.  

__47.  Click on the Started By Me link. 

 
 

__48.  Select the SimpleAccountVerification process template name.  Click on View Process State. 
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__49.  Click on the zoom in button two times. 

 
 

__50.  Hold down the Alt key and then use the cursor to grab and move the diagram to center it. 

__51.  Notice the icons representing the state of each activity ( , , ).  This will indicate the 
execution path. 

 
 

 

Hint 

The icon  indicates that the activity is currently running.  Specifically it shows that 
the Pricing and Approval activity waiting for the human task to complete. 

The icon  indicates that the activity was invoked and finished. 

The icon  indicates that the activity was skipped. 
 
For a complete list, click on the  icon. 

 



IBM   

SOA PoT – Lab handouts, Part 1 Page 139 

 

 

Hint 
The activity state is also displayed on the view when the cursor is placed on the activity. 

 

 

 

Hint 
You can right-click on the Scalable Vector Graphics (SVG) diagram and select Copy 
SVG.  You can then do a Paste Special in WordPad or other editor to copy and paste the 
process state diagram. 

 

10.8 Use the Human Task client to perform Pricing and Approval 

__52.  When you’re finished viewing the process state diagram, switch to the web browser you used to 
start the process. 

__53.  Open the URL http://localhost:9080/PricingandApproval. 

__54.  Click on the Open link. 

 
 

__55.  Click on the PricingandApproval task. 

 
 

 

Hint 
You were not required to log in with a user ID and password because security is 
currently disabled.  This will typically not be the case in production environments.  
Based on the security profile or credentials of the user, the list should only display tasks 
which have been assigned to the user. 

 

http://localhost:9080/PricingandApproval�
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__56.  Click on the Claim button.   

__57.  In the Output Data section, specify Plan ABC in the pricing field. Click on Complete.  

 
 

 

Hint 
You can actually specify any text you want in the pricing field.  This will just be 
displayed as a message in the Console view.  When the Complete button is pressed, the 
output data specified above will be passed back to the SimpleAccountVerification 
process, and the process will resume its execution. 

 

__58.  Switch back to the WebSphere Integration Developer. 

__59.  Switch to the Console view and check for the latest messages. 

 
 
The new messages will indicate that the request is approved.  It will also show the pricing plan 
specified in the Pricing and Approval human task. 

10.9 Cleanup 

__60.  Close the Business Process Choreography Explorer. 

__61.  Close the web browser that you used for the human tasks. 

  

 

  Please wait for the next lecture before proceeding to the next lab. 
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Lab 11 Add New Service Providers 
 

Goals: 

• Ensure success through governance 

• Promote standards and reuse 

o Load WSDLs of approved external Credit Report services 
to the WebSphere Service Registry and Repository 

 

Role:  Architect or Project Manager 
Aside from the Internal Credit Report service, a decision has been made to also start using external 
Credit Report services, such as those provided by Equinox, Experian, and Trans Union.  These credit 
report agencies have supplied the WSDL files needed to access their external web services, and will now 
be published to the WebSphere Service Registry and Repository.  The assumption is that these external 
Credit Report services will be reviewed and approved for use within the organization. 

11.1 Publish the WSDLs for the external Credit Report web services 

__1.  Switch to the web browser showing the WebSphere Registry and Repository console. 

 

 

Troubleshooting 
If the WebSphere Service Registry and Repository console was closed, just start a web 
browser and go to http://localhost:9080/ServiceRegistry.  

 

__2.  If needed, select GP Architect from the Perspective drop-down list.  Click on the Go button. 

 
 

http://localhost:9080/ServiceRegistry�


IBM   

Page 142 SOA PoT  

__3.  Expand the Service Documents section.  Click on WSDL Documents. 

 
You should see the two WSDL files loaded earlier. 

 
 

__4.  Click on Load Documents.   

__5.  Click on Browse to select C:\PoT\BPMSOA\EquinoxCreditReportWebService.wsdl. 

 

__6.  Click on OK. 

__7.  Click on Finish. 

 
 

A message appears that the document was loaded successfully. 

 
 

 

What just happened? 
The WSDL file from the Equinox credit report company was loaded in the WebSphere 
Service Registry and Repository.  This WSDL will be reviewed and approved for use 
within the company.  This web service will serve as one of the service endpoints for the 
Credit Report task in the SimpleAccountVerification process. 
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   Please continue to the next lab. 
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Lab 12 Provide Flexibility with an Enterprise Service Bus 
 

Goals: 

• Provide a layer between services for loose-coupling and 
flexibility 

• Use an ESB between service consumers and providers 

o Between BPEL process and Credit Report web services 
 

Role:  Integration Developer 
The WebSphere Enterprise Service Bus provides flexibility at the service connectivity tier.  Currently, the 
SimpleAccountVerification process invokes a specific and fixed web service for the Credit Report activity.  
However, the process now needs to invoke several Credit Report web services depending on specific 
criteria, such as the requested credit limit.  The use of mediation modules will allow the connectivity and 
routing logic to be extracted from the main process.  This is loose-coupling taken to another level, or the 
connectivity level.  It is another layer of abstraction where the main process does not need to know which 
service endpoint will be invoked to perform the requested task.  The process simply needs to invoke a 
generic and abstract service, and the WebSphere Enterprise Service Bus can handle the routing, 
transformation, and mediation of the request to the actual service endpoints.   

 

12.1 Import the Credit Report Web Services 

__1.  Switch to the WebSphere Integration Developer. 
 

 

What’s next? 
In a more realistic development environment, the external Credit Report web services 
will probably be accessed remotely and will not need to be imported into this 
development machine.  However for this lab, you will need to import the web services so 
that these can be deployed before it can be invoked by the BPEL process. 

 

__2.  From the main menu, select File -> Import. 

__3.  Expand the Other category. Select Project Interchange as the import source. Click on Next. 
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__4.  Use the Browse button for the From zip file field to select 
C:\PoT\BPMSOA\CreditReportServices_All_PI.zip.  

 
 

__5.  Click on Select All.  Click on Finish. 

 
 

__6.  From the confirmation window, click on OK to overwrite existing projects. 

 
 

 

What just happened? 
Several new external credit report web services were imported.  The Equinox Credit 
Report web service is what will be used in this lab.  The other web services will be used 
in later labs. 

 

__7.  Switch to the Servers view.  Expand WebSphere Process Server v6.1.  Right-click on 
CreditReportServicesEAR.  From the popup menu, select Restart CreditReportServicesEAR. 
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What’s next? 
Instead of directly invoking a fixed web service (Internal Credit Report), you will 
modify the process to invoke a variable Credit Report web service using an Enterprise 
Service Bus.  Specifically you will create a Mediation module to dynamically invoke 
either the Internal Credit Report or the external Equinox Credit Report web service 
depending on the following: 

 Internal Credit Report - requested credit limit is less than 5000 
 Equinox Credit Report - requested credit limit is 5000 or greater 

 

12.2 Import WSDLs from WebSphere Service Registry and Repository 

__8.  Switch to the Service Registry view. 

 
 

__9.  Right-click anywhere inside the Service Registry view. From the popup menu, select Retrieve 
WSDL documents. 

 
 

A window appears indicating that the documents (WSDL files) were successfully retrieved. 

 
 

__10.  Click on OK. 

__11.  Expand WSDL Documents. Right-click on EquinoxCreditReportWebService.wsdl. 
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__12.  From the popup menu, select Import Document. 

 

__13.  Select SimpleAccountVerification_lib. Click on Finish. 

 
 

__14.  From the Business Integration view, verify that there are now two web services under the Web 
Service Ports of the SimpleAccountVerification_lib module. 

 
 

 

What just happened? 
You imported the WSDLs of the three external Credit Report web services from the 
WebSphere Service Registry and Repository. 

 

12.3 Create a Mediation Module 

__15.  From the main menu, select File -> New -> Mediation Module. 
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__16.  Specify CreditReportServiceRouter for the Module Name.  For the Target Runtime, select 
WebSphere Process Server v6.1.  

 
 

__17.  Click on Next. 

__18.  Select SimpleAccountVerification_lib.  Click on Finish. 

 
 

An Assembly Diagram editor appears containing a Mediation Flow component called 
CreditReportServiceRouter. 

 
 

 

Hint 
Mediation is a way of mediating or intervening dynamically between services. A 
mediation flow implements a mediation.  Mediation flows intercept and modify 
messages that are passed between existing services (providers) and clients (requesters) 
that want to use those services.  A mediation flow provides functions such as message 
logging, data transformation and routing. 

 

12.4 Implement the Mediation Flow 

__19.  Double-click on the CreditReportServiceRouter component.   

A Mediation Flow Editor will appear. 



IBM   

SOA PoT – Lab handouts, Part 1 Page 149 

__20.  Click on the Add Interface button. 

 
 

__21.  Select CreditReport from the list.  Click on OK. 

 
 

A CreditReport Interface component will appear in the Flow editor. 

 
 

__22.  Click on the Add Reference button. 

 
 

__23.  Change the Name to InternalCreditReportPartner.  Select CreditReport from the list.  Click on 
OK. 

 
 

You should now see the CreditReport Interface and InternalCreditReportPartner Reference 
components. 
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__24.  Right-click on the creditReport operation of the CreditReport Interface on the left. 

 
 

__25.  From the popup menu, select Create Operation Connection. 

This will start a connection. 

 
 

__26.  Click on the creditReport operation of InternalCreditReportPartner to complete the connection. 

 
 

 

What just happened? 
You created a connection to indicate that when the creditReport operation of the 
CreditReportServiceRouter is invoked, the request will be passed to the creditReport 
operation of the partner or service provider.  Later you will define the Internal Credit 
Report web service as the service provider or endpoint. 

 

__27.  Click on the Add Reference button again to add a second reference partner. 

 
 

__28.  Change the Name to EquinoxCreditReportPartner.  Select CreditReport from the list.  Click 
on OK. 
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A second reference partner will appear below the InternalCreditReportPartner reference. 

 
 

__29.  Right-click on the creditReport operation of the CreditReport Interface on the left. 

 
 

__30.  From the popup menu, select Create Operation Connection. 

 

__31.  Click on the creditReport operation of EquinoxCreditReportPartner to complete the connection. 

 
 

 

What just happened? 
With a second connection, you are now indicating that when the creditReport operation 
of the CreditReportServiceRouter is invoked, the request will be passed to either the 
Internal Credit Report web service or the Equinox Credit Report web service.  You will 
set up this routing logic in the next steps. 

 

__32.  From the Palette, expand the Routing folder.  Select the Message Filter primitive. 
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Hint 
The lower area of the Mediation Flow Editor with the Palette is the Request/Response 
flow editor.  The tabs at the bottom of the flow editor allows you to switch between the 
Request and Response editors.   

 
 
You are currently working with the Request flow editor. 

  

__33.  Click to drop the Message Filter into the Request flow editor in the area indicated by the 
following screenshot.  Rename MessageFilter1 to Service Router. 

 
 

__34.  Move the mouse on top of the out terminal for the Input node. 

 
 
This will expose the yellow connector. 
 

 
 

__35.  Connect the yellow connector to the in terminal of ServiceRouter. 

 
 



IBM   

SOA PoT – Lab handouts, Part 1 Page 153 

__36.  Right-click on ServiceRouter.  From the popup menu, select Add Output Terminal. 

__37.  From the New Dynamic Terminal window, specify external as the Terminal name. 

 
 

__38.  Click on OK. 
 
This will add a second terminal to ServiceRouter. 
 

 
 

12.5 Define the Routing Logic to the external Equinox Credit Report Service 

__39.  Right-click ServiceRouter.  From the popup menu, select Show in Properties. 

__40.  Click on the Details tab. 

 
 

__41.  Click on Add. 
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__42.  From the Add/Edit window, click on Edit. 

 
 
 

 

What’s next? 
You will define the criteria to determine when the request will be routed to the external 
terminal.  The external terminal will then be linked to the Equinox Credit Report service. 

 

__43.  From the XPath Expression Builder window, expand Data Types to select the requestedLimit 
attribute. 

 
 
 

 

Hint 
These are the attributes of the CustomerApplication business object which will be passed 
into this CreditReportServiceRouter Mediation Module. 
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__44.  Drag and drop the requestedLimit attribute to the XPath Expression source viewer. 

 
 

The XPath Expression viewer should now contain the expression 
/body/creditReport/Input/requestedLimit. 
 

 
 

__45.  Add the text “>=5000” to the end of the XPath expression.  The full expression should be 
“/body/creditReport/Input/requestedLimit>=5000”. 

 

 
 

__46.  Click on Finish. 

__47.  From the Add/Edit window, click on Finish. 

__48.  From the Request Flow editor, connect the ServiceRouter out terminal (upper) to the topmost 
Callout node. 
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__49.  Connect the ServiceRouter premium terminal (middle) to the second InputCriterion : 
CreditReportPartner1 Callout node. 

 
 

 

What just happened? 
The routing logic was defined so that any request submitted with a requestedLimit of 
5000 or more will be forwarded to the external Equinox Credit Report service.  A value 
of less than 5000 will be routed to the Internal Credit Report service. 
 
The Request Flow is now complete.  The next step is to complete the logic for the 
Response Flow. 

  

__50.  From the Flow editor, click on the Response: creditReport tab at the bottom.   

 
 
This will switch to the Response Flow Editor. 

 

__51.  Connect the out terminals of both Callout Response nodes to the in terminal of the Input 
Response node. 

 
 

 

Hint 
There is no special routing logic needed for the Response flow.  Output will simply be 
passed back to the calling component. 
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__52.  Press Ctrl+s to save the Mediation Flow. 

__53.  Close the Mediation Flow Editor. 

Focus should return to the Assembly Diagram editor for CreditReportServiceRouter.   

12.6 Complete the CreditReportServiceRouter assembly diagram 

__54.  Right-click on CreditReportServiceRouter.   

 

__55.  From the popup menu, select Synchronize Interfaces and References -> from 
Implementation. 

 
 

__56.  From the confirmation window, click Yes. 

 

 

What happened? 
When you implemented the CreditReportServiceRouter using the Mediation Flow editor, 
you added two references, the InternalCreditReportPartner and the 
EquinoxCreditReportPartner.  The CreditReportServiceRouter component in the 
assembly diagram did not reflect this yet, so it needed to be refreshed, or synchronized 
with its current implementation.  After the component was synchronized, the red ‘x’ icon 
was cleared. 

 

What’s next? 
You will now link the references specified in the CreditReportServiceRouter mediation 
flow to its corresponding web services. 

 

__57.  Right-click on an empty space in the canvas. From the popup menu, select Arrange Contents 
Automatically. 
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__58.  From the Business Integration view, drag and drop the InternalCreditReportWebServicePort to 
the assembly diagram. 

 
 

__59.  From the Component Creation window, select Import with Web Service Binding.  Click on OK. 

 
 

__60.  From the Business Integration view, drag and drop the EquinoxCreditReportWebServicePort 
to the assembly diagram. 

 
 

__61.  From the Component Creation window, select Import with Web Service Binding.  Click on OK. 

 
 

__62.  Press Ctrl+s to save your current progress. 

__63.  Right-click on CreditReportImport1.   
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__64.  From the popup menu, select Refactor -> Rename. 

__65.  Change the name to InternalCreditReport.  Click on OK. 

 
 

__66.  Right-click on CreditReportImport2.   

__67.  From the popup menu, select Refactor -> Rename. 

__68.  Change the name to EquinoxCreditReport.  Click on OK. 

 
 

__69.  From the Palette, click on the Wire icon. 

 
 

__70.  Connect the upper reference point of the CreditReportServiceRouter to InternalCreditReport. 
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__71.  Connect the lower reference point of the CreditReportServiceRouter to EquinoxCreditReport. 

 
 

The layout will automatically be rearranged. 

 
 

__72.  From the Palette, click on the Selection Tool icon. 

 
 

__73.  Right-click on CreditReportServiceRouter.   

 
 

__74.  From the popup menu, select Generate Export -> SCA Binding. 

 
 

__75.  Press Ctrl+s to save the CreditReportServiceRouter Assembly Diagram. 

 

 

What happened? 
All the components have now been assembled for the CreditReportServiceRouter.  This 
mediation flow has been set up so that requests for a Credit Report will be forwarded to 
either the Internal or the Equinox Credit Report web service depending on the requested 
credit limit. 



IBM   

SOA PoT – Lab handouts, Part 1 Page 161 

 

__76.  Switch to the Problems view.  Verify that no errors exist (messages with a red ‘x’ mark ).  
Warnings and information messages are expected.  

__77.  Close the Assembly Diagram editor for CreditReportServiceRouter.   

 
 

Focus should return to the SimpleAccountVerification_impl Assembly Diagram editor. 

 

 

What’s next? 
Instead of only invoking the Internal Credit Report web service, you will now use the 
WebSphere Enterprise Service Bus.  The static web service component will be replaced 
by the CreditReportServiceRouter mediation component so that requests can be 
dynamically routed to either the Internal Credit Report web service or the Equinox 
Credit Report web service. 

 

12.7 Re-assemble the SimpleAccountVerification to use the 
CreditReportServiceRouter 
 

__78.  From the Assembly Diagram editor, delete the CreditReportImport1 component on the right 
side. 

   
 

This will be replaced by the CreditReportServiceRouter mediation component. 
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__79.  From the Business Integration view, expand CreditReportServiceRouter -> Assembly 
Diagram.  Select CreditReportServiceRouterExport.  Drag and drop to an empty space in the 
Assembly Diagram editor. 

 
 

__80.  From the Component Creation window, select Import with SCA Binding. Click on OK. 

 
 

__81.  Right-click on Import1.  From the popup menu, select Refactor -> Rename. 

__82.  Click on OK to save the assembly diagram before refactoring. 

__83.  Change the name of Import1 to CreditReportServiceRouter.  Click on OK. 

 
 

__84.  From the Palette, click on the Wire icon to switch to connection mode.   

__85.  Click on CreditReport to start a connection. 
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__86.  Click on CreditReportServiceRouter to complete the connection. 

 
 

__87.  From the Palette, click on the Selection Tool icon.   

__88.  Press Ctrl+s to save the changes. 

__89.  Switch to the Problems view.  Verify that no errors exist (messages with a red ‘x’ mark ).  
Warnings and information messages are expected. 

12.8 Retest the SimpleAccountVerification Process 

__90.  Switch to the Servers view. 

__91.  Right-click on WebSphere Process Server v6.1.  From the popup menu, select Add and 
Remove projects. 

__92.  From the Add and Remove Projects window, click on Add All.  

__93.  Click on Finish.   

__94.  The server state will change to Publishing. You will also see a progress indicator at the bottom.  

 
 

__95.  Wait for the progress indicator at the bottom to disappear. From the Servers view, check that the 
server state has changed to Synchronized. 

 
 

 

What’s next? 
You will now retest the SimpleAccountVerification process.  This time, either the 
Internal Credit Report or the external Equinox Credit Report web service will be 
dynamically invoked depending on the following: 

 Internal Credit Report - requested credit limit is less than 5000 
 Equinox Credit Report - requested credit limit is 5000 or greater 
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__96.  Right-click on WebSphere Process Server v6.1.  From the popup menu, select Launch -> 
Business Process Choreographer Explorer. 
  

 

Hint 
You now have another way of starting the process.  You can also use a web browser 
(http://localhost:9080/StartProcess), instead of using the Business Process 
Choreographer Explorer.  

 

__97.  Click on the My Process Templates link to display a list of processes which can be started. 

 
 

__98.  Place a checkmark beside SimpleAccountVerification. Click on Start Instance. 

 
 

__99.  From the input page, specify a requestedLimit of 1000 or any amount below 5000.  Click on Add. 

 
 

__100.  For the customerID field, type 123. 

 
 

 

Hint 
You specified a Customer ID of “123” so that the process will follow the ‘denied’ 
execution path and bypass the human task.  This will simplify the test.  Specifying a 
different Customer ID will go through the ‘accepted’ execution path and will require a 
response from the Pricing and Approval human task.  At this point, you are only testing 
to determine which web service will be invoked. 

 

http://localhost:9080/StartProcess�


IBM   

SOA PoT – Lab handouts, Part 1 Page 165 

__101.  Click on Submit.   

__102.  After a few moments, the process will generate messages to the Console. 

__103.  Verify that the Internal Credit Report web service was invoked. 

 
 

__104.  Restart the SimpleAccountVerification process again. 

 
 

__105.  This time, specify a requestedLimit of 6000 or any amount greater than 5000.  Click on Add. 

 
 

__106.  For the customerID field, type 123. 

 
 

__107.  Click on Submit.   

__108.  After a few moments, the process will generate messages to the Console. 

__109.  Verify that the Equinox Credit Report web service was invoked. 
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What just happened? 
You have successfully implemented an Enterprise Service Bus mediation component to 
enable dynamic routing of Credit Report requests. 

 

12.9 Cleanup 

__110.  When you’re done testing the process, close the Business Process Choreographer Explorer. 

 

 

   Please continue to the next lab. 
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Lab 13 Enable Dynamic Service Invocation 
 

Goals: 

• Enhance process agility 

o Dynamically determine service endpoints at runtime 

o Select endpoints based on classifications and service 
metadata 

o Handle variable number of service endpoints 
 

Role:  Integration Developer / Architect 
This lab will illustrate another level of flexibility through dynamic service invocations.  This will showcase 
how service endpoints can be determined at runtime based on classifications, service metadata, and 
custom properties.  In the current implementation, the ESB Mediation routes requests to either the 
InternalCreditReport web service or the external EquinoxCreditReport web service depending on the 
requested credit limit.  Both web services are known by the ESB Mediation module.  However, for added 
flexibility, the requirement now involves routing requests to web services that are only determined at 
runtime.  The number of web services involved can also vary at runtime.   

For this lab, you will modify the implementation of the mediation component to enable dynamic lookups 
of available services at runtime from the WebSphere Service Registry and Repository.  Specifically, the 
process should only search for Credit Report web services at runtime that are classified for “Production” 
and have a status of “available”.  New web services can also be added and made available to the 
process at runtime.  Obsolete web services can dynamically be removed as well. 

 

13.1 Add custom properties to the web services 
 

Role:  Architect 

__1.  Switch to the web browser showing the WebSphere Service Registry and Repository console. 

 

 

Troubleshooting 
If the WebSphere Service Registry and Repository console was closed, just start a web 
browser and go to http://localhost:9080/ServiceRegistry.  

 

http://localhost:9080/ServiceRegistry�
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__2.  Expand the Service Metadata -> WSDL.  Click on Ports. 

 

 
 

__3.  Click on the Select all items button. 

 
 

__4.  Click on the Add Property button.   

 

__5.  Specify a property name of Status.  Specify a value of available. 

 
 

__6.  Click on OK.   

 

 

What just happened? 
The Status property will be used at runtime to determine which web service to use.  In 
the lab scenario, only services with an “available” status will be used. 

 



IBM   

SOA PoT – Lab handouts, Part 1 Page 169 

13.2 Specify the classification of the web services 
 

__7.  Select InternalCreditReportWebServicePort. 

 
 

__8.  Click on the Add Classifications button.   

__9.  Expand Governance Profile Taxonomy -> Environment.  Select the Production classification.  
Click on Add. 

 
 

__10.  Click on Production in the Classification list. 

 
 

__11.  In the Details section below, notice the URI.  This will be used later as a lookup criteria when you 
implement the mediation flow. 

 
 

__12.  Click on OK.   
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What just happened? 
The Environment classification will be used at runtime to determine which web service 
to use.  In the lab scenario, only services classified as “Production” ready will be used. 

 

13.3 Create the Dynamic Credit Report Service Mediation Module 
 

Role:  Integration Developer 

__13.  Switch back to the WebSphere Integration Developer. 

__14.  From the main menu, select File -> New -> Mediation Module. 

 
 

__15.  Specify DynamicCreditReportService for the Module Name.  For the Target Runtime, select 
WebSphere Process Server v6.1.  

 
 

__16.  Click on Next. 

__17.  Select SimpleAccountVerification_lib.  Click on Finish. 
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An Assembly Diagram editor appears containing a Mediation Flow component called 
DynamicCreditReportService. 

 

 
 

13.4 Implement the Mediation Flow 

__18.  Double-click on the DynamicCreditReportService component.   

A Mediation Flow Editor will appear. 

 

__19.  Click on the Add Interface button. 

 
 

__20.  Select CreditReport from the list.  Click on OK. 

 
 

A CreditReport Interface component will appear in the Flow editor. 

 
 

__21.  Click on the Add Reference button. 
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__22.  Change the Name to DynamicCreditReportPartner.  Select CreditReport from the list.  Click 
on OK. 

 
 

You should now see the CreditReport Interface and DynamiclCreditReportPartner Reference 
components. 

    
 

__23.  Right-click on the creditReport operation of the CreditReport Interface on the left. 

 
 

__24.  From the popup menu, select Create Operation Connection. 

This will start a connection. 

 
 

__25.  Click on the creditReport operation of DynamicCreditReportPartner to complete the connection. 

 
 

__26.  From the Palette, expand the Routing folder.  Select the Endpoint Lookup primitive. 
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__27.  Click to drop the Endpoint Lookup in the area indicated by the following screenshot.  Rename 
EndpointLookup1 to DynamicServiceRouter. 

 

__28.  Move the mouse on top of the out terminal for the Input node. 

 
 
This will expose the yellow connector. 
 

 
 

__29.  Connect the yellow connector to the in terminal of DynamicServiceRouter. 

 
 

13.5 Define the service endpoint lookup criteria 

__30.  Right-click on the DynamicServiceRouter primitive.   

 
 

__31.  From the popup menu, select Show in Properties. 

__32.  Click on the Details tab. 



IBM   

Page 174 SOA PoT  

__33.  For the Name, use the Browse button to select CreditReport.   

 
 

__34.  For the Registry Name, specify wsrrpot.  For the match policy, select Return all matching 
endpoints and set alternate routing targets. 

 
 

 

Hint 
The Registry Name “wsrrpot” is the alias of a WebSphere Service Registry and 
Repository server that was previously defined as part of the WebSphere Process Server 
configuration. 

 

__35.  Click on the Advanced tab.   

 

 

What’s next? 
You will now be specifying the criteria to determine how services will be selected from 
the WebSphere Service Registry and Repository.  The first criteria will be based on 
classifications.  For this lab, only Credit Report web services with a classification of 
“Production” will be selected.  To add classifications as a lookup criteria, you will use 
the URI of the classification.  

 

__36.  Switch to the PoT Lab Shortcuts folder.  Double-click on the Misc.txt link.  Reopen the folder 
from the desktop if needed. 

__37.  From the Misc.txt editor, copy the following text (Ctrl+c or Ctrl+Ins): 

http://www.ibm.com/xmlns/prod/serviceregistry/6/1/GovernanceProfileTaxonomy#Production 

 

  Screenshot continued… 

 …Screenshot continued    
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__38.  Switch to the WebSphere Integration Developer. 

__39.  For Classifications, click on the Add button. 

 
 

__40.  Paste the copied text into the Classification field. 

 
 

__41.  Click on Finish. 

 

 

What’s next? 
For the second lookup criteria, you will use the “Status” property you added earlier to 
the Credit Report web services in the WebSphere Service Registry and Repository.  
Specifically, you will specify that only web services with a Status of “available” will be 
selected. 

 

__42.  Scroll down to the User Properties, and then click on the Add button. 

 
 

__43.  For the Name, specify Status.  For the Type, select string.  For the Value, specify available. 
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__44.  Click on Finish. 

__45.  Connect the out terminal of DynamicServiceRouter to the in terminal of CreditReportPartner. 

 

__46.  Right-click on the Callout node. 

 

__47.  From the popup menu, select Show in Properties. 

__48.  Click on the Retry tab. 

__49.  For the Retry on field, specify Any fault.  For the Retry count, specify 30.  For the Retry delay, 
specify 10. 

 
 

 

Hint 
If the intended Credit Report web services fail, and there are also no alternate web 
services that can be used, then the settings above will allow the WebSphere Enterprise 
Bus to keep retrying up to 30 times in 10 second intervals.  This helps improve process 
reliability. 

 

__50.  Click on the Response: InputCriterion tab to switch to the Response Flow editor. 

 

__51.  Connect the out terminal of Callout Response to the in terminal of Input Response. 
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__52.  Press Ctrl+s to save the Mediation Flow. 

__53.  Close the Mediation Flow Editor. 

Focus should return to the Assembly Diagram editor for DynamicCreditReportService. 

13.6 Complete the DynamicCreditReportService assembly diagram 

__54.  Right-click on DynamicCreditReportService.   

__55.  From the popup menu, select Synchronize Interfaces and References -> from 
Implementation. 

 
 

__56.  From the confirmation window, click Yes. 

 

__57.  Right-click on an empty space in the canvas. From the popup menu, select Arrange Contents 
Automatically if it has not yet been enabled (no check mark). 

 
 

 

What’s next? 
In the previous ESB lab, you used a drag-and-drop approach to completing the 
CreditReportServiceRouter assembly diagram.  You dragged the needed web service 
ports from the Business Integration view to the assembly diagram editor.  For this lab, 
you will use a different approach to completing this assembly diagram.  You will instead 
choose the components using the popup menu. 

 

__58.  Right-click on DynamicCreditReportService.   

 

__59.  From the popup menu, select Wire References to New -> Imports. 
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The DynamicCreditReportPartner component is created and wired to the 
DynamicCreditReportService. 

 
 

__60.  Right-click on DynamicCreditReportService.   

__61.  From the popup menu, select Generate Export -> SCA Binding. 

 
 

__62.  Press Ctrl+s to save the DynamicCreditReportService Assembly Diagram. 

 

 

Hint 
Notice the warning icon on the DynamicCreditReportPartner. 

 
 
This is because only an interface was specified.  No web service port or implementation 
was bound to the component.  However, this is by design. 
  
A web service interface, such as the Credit Report Interface, contains the abstract 
definition of the service operations and associated inputs/outputs.  A web service port 
represents the concrete implementation of the web service, such as the Equinox Credit 
Report Service.  You will not specify a web service port at this time because you only 
need to use the interface.  This will allow the module to dynamically determine which 
web service port to use at runtime. 

 

 

What happened? 
All the components have now been assembled for the DynamicCreditReportService.  
This mediation flow has been set up so that requests for a Credit Report will be 
forwarded to either the Internal or the Equinox Credit Report web service depending on 
the classification and status of the services.  These can be changed at runtime. 

 

__63.  Switch to the Problems view.  Verify that no errors exist (messages with a red ‘x’ mark ).  
Warnings and information messages are expected.  

__64.  Close the Assembly Diagram editor for DynamicCreditReportService. 
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13.7 Re-assemble the SimpleAccountVerification Process to use the 
DynamicCreditReportService Module 

__65.  From the Assembly Diagram editor for SimpleAccountVerification, delete the 
CreditReportServiceRouter component. 

 
This will be replaced by the DynamicCreditReportService mediation component. 

 

__66.  From the Business Integration view, expand DynamicCreditReportService -> Assembly 
Diagram.  Select DynamicCreditReportServiceExport.  Drag and drop to an empty space in 
the Assembly Diagram editor. 

 
 

__67.  From the Component Creation window, select Import with SCA Binding. Click on OK. 

 

__68.  Right-click on Import1.  From the popup menu, select Refactor -> Rename. 

__69.  Click on OK to save the assembly diagram before refactoring. 

__70.  Change the name of Import1 to DynamicCreditReportService.  Click on OK. 
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__71.  Right-click on CreditReport. 

 
 

__72.  From the popup menu, select Wire to Existing. 

 
 

This will create a connection between CreditReport and DynamicCreditReportService. 

 
 

__73.  Press Ctrl+s to save the changes. 

__74.  Switch to the Problems view.  Verify that no errors exist (messages with a red ‘x’ mark ).  
Warnings and information messages are expected. 

 

13.8 Retest the SimpleAccountVerification Process 

__75.  Switch to the Servers view. 

__76.  Right-click on WebSphere Process Server v6.1.  From the popup menu, select Add and 
Remove projects. 

__77.  From the Add and Remove Projects window, click on Add All.  

__78.  Click on Finish.   

__79.  The server state will change to Publishing. You will also see a progress indicator at the bottom.  
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__80.  Wait for the progress indicator at the bottom to disappear. From the Servers view, check that the 
server state has changed to Synchronized. 

 
 

 

What’s next? 
You will now retest the process with its dynamic service invocation capability.  Earlier 
you set the status of both the Internal and Equinox web services as “available”.  
However, only the Internal Credit Report web service was classified as “Production” 
approved.   
 

Web Service Status Classification 

Internal available Production 

Equinox available  

 
Only web services with both a status of “available” and a classification of “Production” 
will be selected by the SimpleAccountVerification process.  For the next test, only the 
Internal web service will be selected. 

 

__81.  Right-click on WebSphere Process Server v6.1.  From the popup menu, select Launch -> 
Business Process Choreographer Explorer. 
  

 

Hint 
You can also start the process from a web browser 
(http://localhost:9080/StartProcess), instead of using the Business Process 
Choreographer Explorer.  

 

__82.  Click on the My Process Templates link to display a list of processes which can be started. 

 
 

__83.  Place a checkmark beside SimpleAccountVerification. Click on Start Instance. 

 
 

http://localhost:9080/StartProcess�
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__84.  Click on Add. 

__85.  For the customerID field, type 123. 

 
 

 

Hint 
You specified a Customer ID of “123” so that the process will follow the ‘denied’ 
execution path and bypass the human task.  At this point, you are only testing to 
determine which web service will be invoked. 

 

__86.  Click on Submit.   

__87.  After a few moments, the process will generate messages to the Console. 

__88.  Verify that the Internal Credit Report web service was invoked. 

 
 

 

What just happened? 
The SimpleAccountVerification process used the Internal Credit Report web service 
because it is the only service with a “Production” classification. 

 

What’s next? 
You will now assume the role of an architect and change the classification of the web 
services to see how this dynamically changes which web service is invoked by the 
process at runtime.  

 

13.9 Change the classification to change the service selection 
 

Role:  Architect 

__89.  Switch to the web browser with the WebSphere Service Registry and Repository console. 

 

 

Troubleshooting 
If the WebSphere Service Registry and Repository console was closed, just start a web 
browser and go to http://localhost:9080/ServiceRegistry.  

http://localhost:9080/ServiceRegistry�
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__90.  Expand the Service Metadata -> WSDL.  Click on Ports. 

 

 
 

__91.  Click on InternalCreditReportWebServicePort. 

 
 

__92.  Click on Classifications. 

 
 

__93.  Select Production from the Classification list.  Click on Remove. 

 
 

__94.  Click on OK.   
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__95.  Click on the Ports link at the top of the page. 

 
 

__96.  Click on EquinoxCreditReportWebServicePort. 

 
 

__97.  Click on Classifications. 

 
 

__98.  Select the Production classification.  Click on Add. 

 
 

__99.  Verify that Production in the Classification list. 
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__100.  Click on OK.   

 

 

What just happened? 
You removed the “Production” classification from the Internal Credit Report web service 
and added it to the Equinox web service. 
 

Web Service Status Classification 

Internal available  

Equinox available Production 

 
Only web services with both a status of “available” and a classification of “Production” 
will be selected by the SimpleAccountVerification process.  For the next test, only 
Equinox will be selected. 

 

13.10 Retest the SimpleAccountVerification Process 
 

Role:  Integration Developer 

__101.  Switch to the WebSphere Integration Developer. 

__102.  Place a checkmark beside SimpleAccountVerification. Click on Start Instance. 

 
 

__103.  Click on Add. 

__104.  For the customerID field, type 123. 

 
 

 

Hint 
You specified a Customer ID of “123” so that the process will follow the ‘denied’ 
execution path and bypass the human task.  At this point, you are only testing to 
determine which web service will be invoked. 
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__105.  Click on Submit.   

__106.  After a few moments, the process will generate messages to the Console. 

__107.  Verify that the Equinox Credit Report web service was invoked. 

 
 

 

What just happened? 
The SimpleAccountVerification process used the Equinox Credit Report web service 
because it is the only service with a “Production” classification. 

 

 

What’s next? 
You will again assume the role of an architect and add two new Credit Report web 
services, one from Experian and the other from Trans Union.  Both of these new 
services will have a classification of “Production” and a status of “available”.  Finally, 
you will change the status of the Equinox web service to “offline”.  The process should 
only select either the Experian or the Trans Union web services. 

 

13.11 Dynamically add two new Credit Report services and have these 
services available for the process at runtime 

 

Role:  Architect 

__108.  Switch to the web browser with the WebSphere Service Registry and Repository console. 

__109.  Expand the Service Documents section.  Click on WSDL Documents. 

 
 

__110.  Click on Load Documents.   

 

__111.  Click on Browse to select C:\PoT\BPMSOA\ExperianCreditReportWebService.wsdl. 
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__112.  Click on OK. 

__113.  Click on Add Another Document.   

 

__114.  Click on Browse to select C:\PoT\BPMSOA\TransUnionCreditReportWebService.wsdl. 

__115.  Click on OK. 

 

__116.  Verify that the WSDL files for the two new external credit report services appear on the list. 

 
 

__117.  Click on Finish.   

A message appears that the documents were loaded successfully. 

 
 

 

What just happened? 
The WSDL files from the two new external credit report agencies (Experian, Trans 
Union) were loaded in the WebSphere Service Registry and Repository.  These WSDLs 
will be reviewed and approved for use within the company.  These web services will 
serve as additional service endpoints for the Credit Report task in the 
SimpleAccountVerification process. 
 
This illustrates how a dynamic service invocation approach will allow new service 
providers to participate in business processes at runtime.  New web services can be used 
by the process without code modifications and redeployments.  
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__118.  Expand the Service Metadata -> WSDL.  Click on Ports. 

 
 

__119.  Click on EquinoxCreditReportWebServicePort. 

__120.  Click on Properties. 

 
 

__121.  Click on Status. 

__122.  Change the value to offline. 

 
 

__123.  Click on OK. 

__124.  From the Service Metadata section, click on Ports again. 
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__125.  Select ExperianCreditReportWebServicePort and 
TransUnionCreditReportWebServicePort. 

 
 

__126.  Click on the Add Property button.   

__127.  Specify a property name of Status.  Specify a value of available. 

 
 

__128.  Click on OK.   

__129.  Select ExperianCreditReportWebServicePort and TransUnionCreditReportWebServicePort 
again. 

 
 

__130.  Click on the Add Classifications button.   

__131.  Select the Production classification.  Click on Add. 
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__132.  Verify that Production in the Classification list. 

 
 

__133.  Click on OK.   

 

 

What just happened? 
You added two new Credit Report web services (Experian, TransUnion), added 
classifications, and set the status properties.  Here is a summary of the state of each 
Credit Report web service: 
 

Web Service Status Classification 

Internal available  

Equinox  Production 

Experian available Production 

TransUnion available Production 

 
Only web services with both a status of “available” and a classification of “Production” 
will be selected by the SimpleAccountVerification process.  For the next test, only 
Experian or TransUnion can be selected. 

 

13.12 Retest the SimpleAccountVerification Process 
 

Role:  Integration Developer 

__134.  Switch to the WebSphere Integration Developer. 
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__135.  Place a checkmark beside SimpleAccountVerification. Click on Start Instance. 

 
 

__136.  Click on Add. 

__137.  For the customerID field, type 123. 

 
 

 

Hint 
You specified a Customer ID of “123” so that the process will follow the ‘denied’ 
execution path and bypass the human task.  At this point, you are only testing to 
determine which web service will be invoked. 

 

__138.  Click on Submit.   

 

__139.  After a few moments, the process will generate messages to the Console. 

__140.  Verify that either the Experian … 

 
… or TransUnion Credit Report web service was invoked. 

 
 

 

What just happened? 
The SimpleAccountVerification process selected either the TransUnion or Experian 
Credit Report web service because these are the only web services with a classification 
of “Production” and a status of “available” 
 
Because two services can be selected, if one web service fails, then the process will 
select the other web service that is available and production ready.  This helps improve 
process reliability. 
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What’s next? 
There was another option that you set earlier which also helps improve process 
reliability.  This was the retry option in the mediation flow.  You will now test that retry 
capability.  You will shut down all Credit Report web services, and although this will 
generate exceptions, the mediation component will keep retrying up to 30 times in 10 
second intervals. 

 

__141.  Switch to the Servers view. 

 

 

 

__142.  Expand WebSphere Process Server v6.1.  Right-click on CreditReportServicesEAR. 

 
 

__143.  From the popup menu, select Remove. 

__144.  From the confirmation window, click on OK. 

 
 

__145.  Wait for the progress indicator at the bottom to disappear before proceeding. 

 

 

What just happened? 
You shut down all the Credit Report web services by removing these from the server. 
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__146.  Place a checkmark beside SimpleAccountVerification. Click on Start Instance. 

 
 

__147.  Click on Add. 

__148.  For the customerID field, type 123. 

 
 

__149.  Click on Submit.   

__150.  After a few moments, the process will generate messages to the Console.  This time you will 
see repeating exceptions because the WebSphere Enterprise Service Bus is continuously 
retrying. 

 
 

 

What’s next? 
With the retry option configured for 30 attempts and 10 seconds between each attempt, 
you have approximately 5 minutes to restart the Credit Report web services.   

 

__151.  Switch to the Servers view. 

__152.  Right-click on WebSphere Process Server v6.1.  From the popup menu, select Add and 
Remove projects. 

__153.  From the Add and Remove Projects window, click on Add All.  
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__154.  Click on Finish. 

After a few moments, you will see messages in the Console view indicating that the process was 
able to invoke either the Experian … 

 
 

… or TransUnion Credit Report web service. 

 
 

 

What just happened? 
When an invocation of a web service failed, the WebSphere Enterprise Service Bus 
continued to try and access the web service based on the configured retry count and 
delay.  This retry capability will significantly improve process and service reliability. 

 

13.13 Cleanup 

__155.  When you’re finished testing, close the Business Process Choreography Explorer. 

__156.  Close the Misc.txt editor. 

 

 

 
 
Congratulations!   

You have successfully completed all the labs.     
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Conclusion 
 

Hopefully these labs helped illustrate the significant benefits which can be achieved using 
IBM’s SOA Foundation and the WebSphere Business Process Management software 
portfolio. 
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Appendix A. Loading Lab Solutions 
In case you encounter problems, or just wish to skip ahead to the solution of a specific part in the 
lab, then the completed projects are also available.  The solutions can be imported as Project 
Interchange files located in the following directory: 

 C:\PoT\BPMSOA\Solutions 

Below is a list of the solution files which can be found in the directory above. 

 

ModelerLabCompleted.mar Lab ? fully completed  (WebSphere 
Business Modeler) 

JavaLabCompleted_PI.zip Lab ? fully completed 

WebServiceLabCompleted_PI.zip Lab ? fully completed 

BusinessRulesLabCompleted_PI.zip Lab ? fully completed 

HumanTaskLabCompleted_PI.zip Lab ? fully completed 

ESBLabCompleted_PI.zip Lab ? fully completed 

DynamicServiceLabCompleted_PI.zip Lab ? fully completed 

 

Steps for loading a solution file into the WebSphere Integration Developer: 

1. Ask for assistance from the instructors or lab assistants if necessary. 
2. Remove all applications currently deployed to the test server.  (Refer to the following 

screenshot) 
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3. Delete all projects in the Business Integration view. 
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4. Switch to the J2EE perspective.  Delete all enterprise applications. 
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5. Switch back to the Business Integration perspective. 
6. Import the desired Project Interchange file.  Refer to the solution file table described 

above. 
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7. If a progress indicator appears, wait until it is complete.    
 

 
8. Perform a Project Clean-all. 

 

 
 

 



IBM   

SOA PoT – Lab handouts, Part 1 Page 201 

9. If a progress indicator appears, wait until it is complete.    
 

 
 

10. Ensure that there are no errors listed in the Problems view.  If errors exist, delete the 
following files and perform another Project Clean-all (repeat step 8): 
 
     SimpleAccountVerificationApp 
     SimpleAccountVerificationEJB 
     SimpleAccountVerificationWeb 
 
Do not delete SimpleAccountVerification. 
 

11. Start the test server if not yet started. 
12. Add all projects to the test server. 
13. Proceed to the appropriate section of the lab for testing the process. 
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Appendix B. IBM TechWorks  
TechWorks is a worldwide team serving IBM software sales, technical, and development professionals 
and through these organizations our customers and partners. The TechWorks organization works to:  

• Provide implementation, execution, and expertise for brand and general technical sales 
strategies and objectives 

• Provide deep technical and product knowledge directly to customers and partners 
• Create material to teach our field teams, our partners, and our customers about what IBM 

products can do  
• Operate world-class, high-quality facilities that support and enhance the interactions between 

our field technical sales team and our clients and partners 

For more information about IBM TechWorks, talk with your IBM sales representative. 
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Appendix C. Notices 
This information was developed for products and services offered in the U.S.A.  

IBM may not offer the products, services, or features discussed in this document in other countries. 
Consult your local IBM representative for information on the products and services currently available in 
your area. Any reference to an IBM product, program, or service is not intended to state or imply that 
only that IBM product, program, or service may be used. Any functionally equivalent product, program, or 
service that does not infringe any IBM intellectual property right may be used instead. However, it is the 
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.  

IBM may have patents or pending patent applications covering subject matter described in this 
document. The furnishing of this document does not grant you any license to these patents. You can 
send license inquiries, in writing, to:  

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A.  

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property 
Department in your country or send inquiries, in writing, to:  

IBM World Trade Asia Corporation 
Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106-0032, Japan  

The following paragraph does not apply to the United Kingdom or any other country where such 
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES 
CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some 
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this 
statement may not apply to you.  

This information could include technical inaccuracies or typographical errors. Changes are periodically 
made to the information herein; these changes will be incorporated in new editions of the publication. 
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice.  

Any references in this information to non-IBM Web sites are provided for convenience only and do not in 
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part 
of the materials for this IBM product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes appropriate without 
incurring any obligation to you. 

Any performance data contained herein was determined in a controlled environment. Therefore, the 
results obtained in other operating environments may vary significantly. Some measurements may have 
been made on development-level systems and there is no guarantee that these measurements will be 
the same on generally available systems. Furthermore, some measurements may have been estimated 
through extrapolation. Actual results may vary. Users of this document should verify the applicable data 
for their specific environment.  
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Information concerning non-IBM products was obtained from the suppliers of those products, their 
published announcements or other publicly available sources. IBM has not tested those products and 
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM 
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of 
those products. 

All statements regarding IBM's future direction and intent are subject to change or withdrawal without 
notice, and represent goals and objectives only. 

This information contains examples of data and reports used in daily business operations. To illustrate 
them as completely as possible, the examples include the names of individuals, companies, brands, and 
products. All of these names are fictitious and any similarity to the names and addresses used by an 
actual business enterprise is entirely coincidental.  

 

COPYRIGHT LICENSE:  

This information contains sample application programs in source language, which illustrate programming 
techniques on various operating platforms. You may copy, modify, and distribute these sample programs 
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing 
application programs conforming to the application programming interface for the operating platform for 
which the sample programs are written. These examples have not been thoroughly tested under all 
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these 
programs. 



IBM   

SOA PoT – Lab handouts, Part 1 Page 205 

Appendix D. Trademarks and copyrights 
The following terms are trademarks of International Business Machines Corporation in the United States, 
other countries, or both: 

      
IBM  IBM logo Cool Blue DB2 Lotus WebSphere 
System i iSeries AIX CICS ClearCase Cloudscape 
DataPower FileNet i5/OS Informix IMS pSeries 
Rational z/OS zSeries    
      

Adobe, Acrobat, Portable Document Format (PDF), and PostScript are either registered trademarks or 
trademarks of Adobe Systems Incorporated in the United States, other countries, or both. 

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. in the United 
States, other countries, or both. See Java Guidelines  

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the 
United States, other countries, or both.  

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both. 

Other company, product and service names may be trademarks or service marks of others. 

 


	Icons
	Lab 1 Promote Standards and Initiate Governance
	Goals:
	 Ensure success of SOA projects
	o Initiate lifecycle governance
	o Reuse assets and promote standards
	 Align business with IT
	o Define classifications
	1.1 Open the WebSphere Service Registry and Repository console
	1.2 Switch to a different profile
	1.3 Define how services should be classified
	1.4 Load the standard data object definitions
	1.5 Define a new business process and apply governance

	Lab 2 Model the Business Process
	Goals:
	 Align IT to business processes
	o Initiate business-driven development
	o IT organized as business tasks and services
	 Capture more precise business models
	 Lower business costs
	o Run simulations before allocating time and resources
	2.1 Start the WebSphere Business Modeler
	2.2 Define the business model
	2.3 Connect tasks to define process flow
	2.4 Export the business model as a BPEL process

	Lab 3 Apply Governance to the Process Lifecycle
	Goals:
	 Ensure success through lifecycle governance
	o Transition from model phase to assemble phase
	3.1 Transition SimpleAccountVerification Process to Assemble State

	Lab 4  Assemble and Deploy the Process
	Goals:
	 Assemble service components to form business process
	 Lower business costs and achieve IT flexibility
	o Apply the building-block approach
	o Integrate using modular service components
	o Loosely-couple service components for flexibility
	4.1 Start the WebSphere Integration Developer
	4.2 Import the business model into the WebSphere Integration Developer
	4.3 Assemble the business process
	4.4 Implement the tasks of the business process
	4.5 Deploy and test the business process
	4.6 Cleanup

	Lab 5 Publish Service Interface for Reuse
	Goals:
	 Encourage reuse at the enterprise level
	 Promote standards
	5.1 Publish the Credit Report Service Interface

	Lab 6 Explore a Web Service Endpoint
	Goals:
	 Explore the Internal Credit Report Web Service
	6.1 Import the completed web service
	6.2 Explore the web service artifacts
	6.3 Publish the Web Service
	6.4 Check the WebSphere Service Registry and Repository

	Lab 7 Change Service Implementation
	Goals:
	 Respond to changing business needs
	 Take advantage of IT flexibility provided by infrastructure
	 Quickly change implementation of business tasks
	7.1 Import the web service WSDL from the WebSphere Service Registry and Repository
	7.2 Change the Credit Report task to a Web Service Implementation
	7.3 Retest the SimpleAccountVerification Process
	7.4 Cleanup

	Lab 8 Externalize Business Rules
	Goals:
	 Achieve business agility
	 Allow changes to business rules at runtime
	o No recoding, retesting, and redeploying
	8.1 Change the Credit Risk Assessment Task to a Business Rule
	8.2 Define the Business Rule Set
	8.3 Save and Verify the Business Rule
	8.4 Retest the SimpleAccountVerification Process
	8.5 Modify the Credit Assessment Business Rule at Runtime
	8.6 Reset the Credit Risk Assessment Business Rule

	Lab 9 Modify the Process Choreography
	Goals:
	 Add a task to the BPEL process 
	9.1 Define the Interface for the new ‘Generate Acceptance’ task
	9.2 Add the GenerateAcceptance Task to the SimpleAccountVerification BPEL Process
	9.3 Add the implementation for the new Generate Acceptance task

	Lab 10 Incorporate Human Tasks
	Goals:
	 Integrate business processes end-to-end
	 Include human tasks with automated business processes
	o Assign the right work to the right people at the right time
	o Human task must be repeatable, reusable, auditable
	10.1 Create a Human Task to start the process
	10.2 Convert the Pricing and Approval Java component to a Human Task
	10.3 Generate a web client for the Start Process Human Task
	10.4 Generate a web client for the Pricing and Approval Human Task
	10.5 Retest the SimpleAccountVerification process
	10.6 Use the Human Task client to start the process
	10.7 View the Process State
	10.8 Use the Human Task client to perform Pricing and Approval
	10.9 Cleanup

	Lab 11 Add New Service Providers
	Goals:
	 Ensure success through governance
	 Promote standards and reuse
	o Load WSDLs of approved external Credit Report services to the WebSphere Service Registry and Repository
	11.1 Publish the WSDLs for the external Credit Report web services

	Lab 12 Provide Flexibility with an Enterprise Service Bus
	Goals:
	 Provide a layer between services for loose-coupling and flexibility
	 Use an ESB between service consumers and providers
	o Between BPEL process and Credit Report web services
	12.1 Import the Credit Report Web Services
	12.2 Import WSDLs from WebSphere Service Registry and Repository
	12.3 Create a Mediation Module
	12.4 Implement the Mediation Flow
	12.5 Define the Routing Logic to the external Equinox Credit Report Service
	12.6 Complete the CreditReportServiceRouter assembly diagram
	12.7 Re-assemble the SimpleAccountVerification to use the CreditReportServiceRouter
	12.8 Retest the SimpleAccountVerification Process
	12.9 Cleanup

	Lab 13 Enable Dynamic Service Invocation
	Goals:
	 Enhance process agility
	o Dynamically determine service endpoints at runtime
	o Select endpoints based on classifications and service metadata
	o Handle variable number of service endpoints
	13.1 Add custom properties to the web services
	13.2 Specify the classification of the web services
	13.3 Create the Dynamic Credit Report Service Mediation Module
	13.4 Implement the Mediation Flow
	13.5 Define the service endpoint lookup criteria
	13.6 Complete the DynamicCreditReportService assembly diagram
	13.7 Re-assemble the SimpleAccountVerification Process to use the DynamicCreditReportService Module
	13.8 Retest the SimpleAccountVerification Process
	13.9 Change the classification to change the service selection
	13.10 Retest the SimpleAccountVerification Process
	13.11 Dynamically add two new Credit Report services and have these services available for the process at runtime
	13.12 Retest the SimpleAccountVerification Process
	13.13 Cleanup

	Conclusion

